Oracle® Fusion Governance, Risk and Compliance
Intelligence

Implementation Guide

Release 2.0

Part No. E10891-03

October 2008

ORACLE



Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide, Release 2.0
Part No. E10891-03

Copyright © 2007, 2008, Oracle and/or its affiliates. All rights reserved.

Primary Author: Douglas J. Myers

Contributing Author:  Anitha Raghavan, Ashwin Sadanandan, B'far Reza, Chandramoham Subbiah, Denise
Fairbanks Simpson, Hal Kazi, Hernan Capdevila, Hugh Mason, Kim Wilmot, Louis Gonzales, Madhavi
Gopaladasu, Mohamed Hussain, Mumu Pande, Pamela Rietz, Pournima Patil, Prasanna Chimata, Sinha
Siddharth, Srinivasan Ganesan

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks
of their respective owners.

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf
of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication,
disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the
applicable Government contract, and, to the extent applicable by the terms of the Government contract, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle
USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not
developed or intended for use in any inherently dangerous applications, including applications which may
create a risk of personal injury. If you use this software in dangerous applications, then you shall be
responsible to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of
this software. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software in dangerous applications.

This software and documentation may provide access to or information on content, products and services
from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all
warranties of any kind with respect to third party content, products and services. Oracle Corporation and its
affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third
party content, products or services.



Contents

Send Us Your Comments
Preface

1 About Oracle Fusion Governance, Risk and Compliance Intelligence

Product OVeIVIEW.........oi et e s e s me e snee e 1-1
ADBout This GUIdE........c.ooiiiiiiiie e e 1-3
Supported LANGUAGES. .........coouiiiiiiiiiii e e e 1-3
PrerequiSites...........ccooiiiiiiii i 1-4
ReCOMMENAALION. .......oiiiiiiiii it eeneas 1-4

2 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for
GRCM 7.8

L0 3 LU 2-1
Installing Oracle GRCM ScIPts.........oociiiiiiiiiiiiii e 21
Setting Up the Environment..............cccccooiiiiiiiiiiiii 2-2
Creating the Target Physical Model.................ccoooiiiii e 2-17
Loading Target Tables..............cccciiiiiiiiiiiiii e s 2-17
Installing OBIEE RePOTILS.........c.coooiiiiiiiiiiiii e e 2-18
Multi-Language Setup for OBIEE................c..ccooiiiiiiiii e 2-19
Installing BI Publisher Reports.............cc.cccoiiiiiiiiiiiiii e 2-24
Security Integration with GRCM (Optional)...............cccocoiiiiiiiiii s 2-28

3 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for
AACG 8.1.1 or Later

(@ 2 7=5 74 1= 7 TR 3-1



Installing Oracle AACG SCIipts..........ccooiuiiiiiiiicii e 3-1

Installing ODI Code.............ccooiiiiiiiiii 3-2
Installing OBIEE RePOTIES.........c.cooiiiiiiiiiiiiiie e s 3-12
Security Integration with AACG (Optional)............cccoooiiiiiiiiiii e, 3-13

4 Installation and Upgrade Options for Oracle Fusion Governance, Risk and
Compliance Intelligence 2.0

(@ 175 74 1= 7 TR 4-1

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for both GRCM 7.8
and AACG 8. 1.1 0r Later..........ccoooiiiiiiiiiii i 4-1

Upgrading GRCI 1.0 0 GRCI 2.0.........ccuoiiiiiiieiie e 4-2

A ETL Execution

EXecution SEqUENCE. ..........cccooiiiiii e A-1
ETL EXECULION......ccooiiiiiiiiiii e A-2
Execute @ Package............cooooiiiiiii e A-3

B Architecture

Data FIoW Diagrami...........occooiiiiiiiii e B-1
Detailed Data Flow Diagram..............cccccooiiiiiiiiiiiic s B-3

C Logical and Physical Models

Data FIOW DIagrami.........coooooiiiiiiiii e C-1
GRCI - AACG 8.1.1 or later Logical Model................cccociiiiiiiii e, C-1
GRCI - AACG 8.1.1 or later Physical Model.................cccooiiiiiiiiiiiii e C-5
GRCI- GRCM 7.8 Logical Model................cccoiiiiiiiiiiii e C-19
GRCI - GRCM 7.8 Physical Model..............cooiiiiiiiii e C-21

D Lineage for GRCM 7.8

GRCI 2.0 - GRCM 7.8 Data Lineage CONSTANTS Table........c.cccoceiiiiiiiiiiiiiinecce e D-1
GRCI 2.0 - GRCM 7.8 Data Lineage DIMENSIONS Table..............cccoociiiiiiiiiiiicinn, D-5
GRCI 2.0 - GRCM 7.8 Data Lineage FACTS Table..............ccocooiiiiiiiiicec D-10

E Lineage for AACG 8.1.1 or Later

GRCI 2.0 - AACG 8.1.1 or Later, Data Lineage DIMENSIONS Table.................cccocciiinnnns E-1
GRCI 2.0 - AACG 8.1.1 or Later, Data Lineage FACTS Table..............cccccoiiiiiiiiiiniiiiceee E-4
Index



Send Us Your Comments

Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide, Release 2.0
Part No. E10891-03

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document.
Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

¢ Are the implementation steps correct and complete?

¢ Did you understand the context of the procedures?

¢ Did you find any errors in the information?

¢ Does the structure of the information help you with your tasks?

* Do you need different information or graphics? If so, where, and in what format?
* Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the
name of the company who has licensed our products, the title and part number of the documentation and
the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the
document and if any concerns are already addressed. To do this, access the new Applications Release
Online Documentation CD available on Oracle MetaLink and www.oracle.com. It contains the most
current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle
Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office
and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at
www.oracle.com.






Preface

Intended Audience

Welcome to Release 2.0 of the Oracle Fusion Governance, Risk and Compliance Intelligence
Implementation Guide.

Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide
for Release 2.0 is intended for information technology personnel and privileged users
responsible for installing and configuring the GRC Intelligence application. It assumes
the reader is familiar with Oracle Content Server installation, configuration, and use.

See Related Information Sources on page viii for more Oracle Applications product
information.

TTY Relay Access to Oracle Support Services

To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer
Assistant will relay information between the customer and Oracle Support Services at
1.800.223.1711. Complete instructions for using the AT&T relay services are available at
http://www.consumer.att.com/relay/tty/standard2.html. After the AT&T Customer
Assistant contacts Oracle Support Services, an Oracle Support Services engineer will
handle technical issues and provide customer support according to the Oracle service
request process.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and
Oracle is actively engaged with other market-leading technology vendors to address

vii



technical obstacles so that our documentation can be accessible to all of our customers.
For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

Structure

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

1 About Oracle Fusion Governance, Risk and Compliance Intelligence
2 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for GRCM 7.8

3 Installing Oracle Fusion Governance, Risk and Compliance Intelligence for AACG 8.1.1
or Later

4 Installation and Upgrade Options for Oracle Fusion Governance, Risk and Compliance
Intelligence 2.0

A ETL Execution

B Architecture

C Logical and Physical Models

D Lineage for GRCM 7.8

E Lineage for AACG 8.1.1 or Later

Related Information Sources

Oracle Fusion Governance, Risk and Compliance Intelligence User’s Guide

This guide provides information on how to use the Governance, Risk and Compliance
Intelligence application with Oracle Content Server.

Do Not Use Database Tools to Modify Oracle Applications Data

viii

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data unless
otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your



data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an
Oracle Applications form can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your tables
get out of synchronization with each other, you risk retrieving erroneous information
and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps track
of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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About Oracle Fusion Governance, Risk and
Compliance Intelligence

Product Overview

Oracle Fusion Governance, Risk and Compliance Intelligence (GRCI), Release 2.0, is an
intelligence reporting application that extracts data from Oracle Governance, Risk and
Compliance Manager (GRCM), Release 7.8 and Oracle Application Access Control
Governor (AACG) 8.1.1.

The Oracle Fusion Governance, Risk and Compliance Intelligence solution is designed
to enhance your visibility into the organization's compliance readiness and
responsiveness by providing certification, controls, issues, risks, and testing diagnostics
and out-of-the-box management reports. By using Oracle Fusion Governance, Risk and
Compliance Intelligence, you can drill from high-level to detailed information to
effectively plan, model, report, and analyze GRC activities. You can identify potential
issues early and take informed and timely corrective actions.

GRCI Sourced from AACG

¢ GRCI Analytics Integration Overview The source of GRCI Release 2.0 data store is
AACG (Application Access Control Governor) 8.1.1 and information such as
policies, entitlements, exclusions, conflicts etc., are loaded into GRCI staging tables
hosted in the GRCI (data store) schema. This data load is accomplished in a '‘push'’
fashion as opposed to the traditional 'extract' method and it is called Analytics
Integration. Two enhancements were made to the AACG application to integrate
with GRCI:

1. A new tab called 'Analytics Integration' which is available through the Application
Configuration screen. This captures the setup information related to the integration.

2. Conflict run in AACG 8.1.1 or later is enriched with '"AACG data services' to load
data into GRCI staging tables.
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The other source of GRCI is GRCM 7.8 and information such as Processes, Controls,
Risks, Issues etc., from GRCM 7.8 are loaded into GRCI data store tables for
analysis using SQL.

¢ Analytics Integration Schemas The analytics integration component of AACG
application uses two schemas to create necessary data for analysis by GRCI
application. One schema (referred to as ag_access) stores AACG specific data in
tables prefixed with LAA_ and TMP_ and another schema (referred to as gri)
contains the staging tables used by GRCI ETL process. This gri schema contains all
database objects used by the GRCI application.

e Staging Tables Load The gri schema contains the staging tables (prefixed with
GRI_S), which act as an interface between AACG and GRCI applications. These
tables are populated when the user executes the Conflict Run process in AACG
application.

Note: Check the AACG documentation for details on how to
configure the application to connect to GRCI staging schema and
load data into these staging tables.

The staging (GRI_S_) tables are loaded during every execution of Conflict Run and
data is updated in the staging tables in an update-else-insert fashion. Here are two
examples:

1. If the entitlement description or entitlement status changes in AACG, the AACG
data services component will pick up the changes during the next Conflict Run, and
update the staging tables GRI_S_ENTITLEMENT and GRI_S_ENTITLEMENT_TL
with the new values.

2. If the status of a Conflict Path changes from Approved to Rejected in AACG, the
AACG data services component will pick up the changes during the next Conflict
Run and update the staging table GRI_S_CONFLICT_PATH.

¢ GRCI Star Schema Tables Load Data in the GRCI staging schema is refreshed
during every execution of Conflict Run in AACG. So as a best practice it is
recommended that GRCI administrator execute the ODI based ETL packages
immediately after every successful execution of Conflict Run (for ex: Run-1) in
AACG. This would refresh the content of GRCI star schema tables and users can
visualize the latest values in OBIEE based dashboards and reports. If the ETL
packages are not executed before the next Conflict Run (for ex: Run-2) in AACG, the
data in GRCI staging tables will be overwritten before the previous Run's (Run-1)
changes being propagated to GRCI star schema tables.

GRCI Sourced from GRCM GRCM 7.8 is one of the sources of GRCI 2.0, and
information such as Processes, Controls, Significant Accounts, Risks and Issues are
extracted from GRCM and loaded into the GRCI data store. The creation of the GRCI
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Star Schema, Extraction, Transformation and Load of GRCM data into the GRCI star
schema is accomplished using PL/SQL scripts. For further details on implementing
GRCM based GRCI, please refer to Chapter 2.

About This Guide

This document explains how to install the Oracle Fusion Governance, Risk and
Compliance Intelligence application on a Oracle 10g server. The information contained
in this document is subject to change as the product technology evolves and as
hardware, operating systems, and third-party software are created and modified. This
document is intended for information technology personnel and authorized users
responsible for installing and configuring the Oracle Fusion Governance, Risk and
Compliance Intelligence, Release 2.0 application.

Supported Languages

Oracle Fusion Governance, Risk and Compliance Intelligence, Release 2.0 is available in
English only for AACG 8.1.1 or later.

About Language Resource Files

GRCM 7.8 supports the following languages aligned with the Oracle Identity
Management (OIM) product line:

¢ Chinese Traditional
e Chinese Standard

® Spanish

e French

e Japanese

e Portuguese

e Korean

e German

e TJtalian
e Danish
e Dutch

¢ UK English
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Prerequisites

Before you use Oracle Fusion Governance, Risk and Compliance Intelligence, Release
2.0, you must:

* Install Oracle Database 10gR2 with patch 10.2.0.4

¢ Install Oracle Business Intelligence Enterprise Edition 10.1.3.3.3

Install either one or both of the following applications:
® Oracle Governance, Risk and Compliance Manager, Release 7.8
¢ Install Oracle Application Access Control Governor 8.1.1

* Install Oracle Data Integrator 10.1.3

If you have installed Oracle Application Access Control Governor 8.1.1, then:
e Install Oracle Data Integrator 10.1.3

¢ AACG Interface tables (tables with name starting as GRI_S_...) should be deployed
in the same schema as the tables for data warehouse ('GRI' Schema).

Recommendation

It is recommended that the AACG installation and the data warehouse database that
has 'GRI' schema (AACG DB and GRCI DB) be in the same network.
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2

Installing Oracle Fusion Governance, Risk
and Compliance Intelligence for GRCM 7.8

Overview

This chapter covers the installation procedures for GRCI 2.0 when the source
application is solely GRCM 7.8. However, if there is an existing GRCI 1.0 installation,
which needs to be upgraded to GRCI 2.0, please refer to Chapter 4, and follow the
upgrade instructions.

Installing Oracle Scripts contains the following subsections:

1. Setting Up the Environment
2. Creating the Target Physical Model

3. Loading Target Tables

Installing Oracle GRCM Scripts

The GRI_20_GRCM_ETL.zip contains the scripts for the creation of the GRCI 2.0
datastore based on GRCM 7.8. When the scripts are executed as per the steps mentioned
in this section, the GRCI star schema is created and loaded with the data from the
source. With this release GRCI datastore can only be hosted on Oracle, but GRCM
residing on SQLServer or Oracle database platforms can be used as the source.

The extracted zip file contains the following files:

* Model/Constants_Create_pkg.sql
* Model/Dims_Create_pkg.sql

* Model/Facts_Create_pkg.sql
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* Model/Stage_Create_pkg.sql

e Model/Execute_Create.sql

* Model/Execute_Index_View.sql
e ETL/Constants_Load_pkg.sql

e ETL/Dims_Load_pkg.sql

e ETL/Facts_Load_pkg.sql

e ETL/Execute_Load.sql

Important: If you are installing GRC Intelligence Release 2.0 for GRC
Manager and AACG, then AACG Scripts Installation should be
completed first, followed by the GRC Manager Scripts Installation.

Setting Up the Environment

1. Identify the source application database details - host name, port number, user
name, and password.

2. Connect to source database depending upon the type of source: If the source is
ORACLE: Connect to target oracle database using any oracle db connectivity client
(e.g. SQL Developer). Create a database link - GRCM771_APPS_DBLINK pointing
to source database as follows. Replace the contents in <> brackets with the
information in Step1 for creating the db link.

3. CREATE DATABASE LINK GRCM771_APPS_DBLINK CONNECT TO "<user
name>" IDENTIFIED BY "<password>" USING
DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST= <host
name> or IP Address>)(PORT=<port name>)))(CONNECT_DATA
(SERVICE_NAME=<service name>)))

Verify if the database link is working by querying a source table. Refer below for an
example.

SELECT COUNT (*) FROM GRC_FISCAL_PERIODS@ GRCM771_APPS_DBLINK;

If the source is SQL server: For connecting to the SQL server, the Oracle Database
Gateways 11g Release 1 (11.1.0.6.0), should be installed in the oracle home directory of
the database. All versions of gateway before this have been de-supported by Oracle and
cannot be used.

For the Oracle database, a patch should be applied to upgrade it to 10.2.0.4, as the older
versions of Oracle do not support the Unicode data transfer.
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Follow this procedure to install the gateways in a windows Oracle database:

* Run the setup.exe from the install files.

Jrache Universal Installer: Welcoms

s 1L

g Universal Installer; Select a Product to Install

e |
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® Select the Oracle Home directory, for the database on which the gateway is to be
installed.

Oracle Universal Installer: & ify Home Details

Srrcie 11

DATABASE

Dgraclelprogucti! 0.2.0ub_1

® Select the Oracle Database gateway for Microsoft SQL Server 11.1.0.6.0.
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“# Dracle Universal Installer: Available Product Components r-n-_ | ﬁl

ORACLE’ 1 g
DATABASE

Available Product Components
Oracle Database Gateways

The following are componenis thal vou can install s par of Oracle Dalabase Gateways Vihich of these
components do you want {o install?

Components It Stz |
B8 Oracle Dstabase Gabayways 11 1080 Pt iryestal | I
[ Cracde Databecs Gateway for informz 11.1.060 ot Irstailand |
O Cracke Database Galeway lor Sybase 11,1 060 Ml'w
[ Orace Database Gatesvay for Teradsta 111060 It iretatiedd
[ Oracts Datshase Gatewsy for APPC 11 4060 Pl Iretsil=d
y B O Oracie Databeee Gatewny for DROA 111 060 Tot Installed
'.rn'..-.f '_;l:. el :_:_.... .- Lk | n 0 3 b Mm : Nt
Expand All ) Collapsa Al ) Beloci Al _jl ReselectAll |

I St cxpaneris, NG R AT G oRbr

Help | JnshllﬁdErnﬁwﬁs.... ju— Back I um Jo o nstatl cancel |

Enter the SQL server connection details as required.
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@ (racle Universal Installer: Oracle Database Gateway for Microsoft 500 Server

ORACLE’
DATABASE

Oracle Database Gateway for Microsoft SQL Server

Please provide

 [10148.45.242 i

T —

e (Click Next.

* (lick Install and the gateway will start installation.
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@ Oracle Univerzal Installer: Summary

-- &
SRt ff

Summary
Oracle Database Gateways 11.1.0.6.0

S-Global Settings

| Source: DASMAthySomaarewin3z_11gR1_gateways\gatewaysistagerpraducts xmi
—orache Home: Dioraclelproduchd 0,2 Didb_1 (OraDb1 0g_homel)
~Installabon Type: Custom

CHProduct Languages
—English

| C-Space Requinements

| = Reguired 2TME Oncludes I6ME temporanyd | Available 881 GE

|1 —D\ Reguired SEGME - Available 2 93G8

B lreacy nstalled (55 productsh

N 1 '. : e
Help | | Installed Products... J'It Back L_ lset | [ jnetall ) cancel |

Tip: This will take few minutes.
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w Oracle Universal Installer: Install

ORACLE 1 1g

DATABASE

Install

Installing Ovache Dalabase Gateways 11.1.06.0

¥ Inatallation in progress
et Ideal Platform for

Setup pending, . Grid Computing

Condiguration pendng. ..

Low cost sarvars

and slorage
Extracting fles 1o 'Clproducti 1.1 0tg_6'.
. ' 200 Highest availability

Bast scalability

“ou can find the log of fhis instal session et
cﬁwmmﬁmnmwmmmum_tw-m

Help | Inetalled Prodiets 15tk [ Et [netzl| Crennel

®  Once the installation is complete the Oracle net configuration Assistant pops up for
setting up the Listener for the gateway.
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(racle Het Configuration Assistant; Welcome
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Oracle Het Confipuration Assistant: Listener Configuration, Select Protocols

You can configure the listener to accept connections aver one or
maore protocols. Selectwhich prolocols you want 10 configure for this
listener, Keep your configuration as simple as possible by
configuring only the protocols you need.

Available Protocols Selected Profocols

TGRS ] TCP =
IPC: = =
MudP - I :_E I

* Assign the Listener an appropriate name.

(Oracle Met Configuration Assistant: Listener Configuration, Listener Name

Forremaote conneclions to ke made 1o yvour Oracle
database you must have atleast one Oracle Net
listenar. Entar the name of fhe listaner you want to
create;

Listener name: |LISTENERS@L_FCO)|

Cancal Jj Help ) % Back Mewt 2
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Oracle Met Confipuration Assistant: Listener Confipuration, TCP/IP Protocol

Y¥hich TCPAP por number should the listener use? The port
number selected should not be used by any other software on
this computar.

® |ge the standard port number of 1521

" Use another port number: [1 521

Cancel | Help |

Oracle Net Configuration Assistant: Listener Configuration, More Listeners?

Wiould you like to configure another listener?

® g

" Yes

Cancel | Help |
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Oracle Net Configuration Assistant: Listener Configuration Done

Listener configuration completa!

Cancel | Heln | < gack | ped ¥

®  Once the listener configuration is complete, keep clicking the "next" till the
configuration is successfully complete.
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Oracle Met Configuration Assistant: Maming Methods Configuration

When connecting to a database or other senvice, you specify a
cannect identifier, such as a net sevice name. The connect
Identifiar is resoklved into & connect descriplor by one or more
naming methods. By default, the local naming method (nsnames.
ora file} is configured for enabling the semver to connect back to
itself.

Ifyvou need this server to connect to other semvers, oryvou want to
use this Cracle Home as & client, then you might need to
configure additional naming methods.

Do you want to configure additional naming methods?

® Mo, | do not want fo configure additional n&ming methods.

" *as, | dowantio configure additional naming methods,

Oracle Met Configuration Complete,

Cancel ) Help )

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for GRCM 7.8 2-13



® Oracle Universal Installer: End of Installation
DATABASE

End of Installation

®  Once the gateway has been successfully installed, you can find the folder for the
database gateway in the Oracle home directory.
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Fis Ed Wew Favorkes Took Help

Q- (T st [ radens

Ackireas || ) Driorackelproduct} 10, 2,000 _Lydgemsgh admin
Folders

= 2 1k1.0
& ) admn
W ichdb_i
D2
) Flash_recoresry_anta
L] oradata
= 3 1k2.0
® 3 admn
= d 1
# | admin
+ |3 assistants
B
2ox
3 odats
3 dfigtodling=
I clane
£ com

HEHEE®

& X9 [E

-~

:_-_:I dgdmsg)_cuw sgl
2] dgame)_txsal

il g e or s
H ritdpimeg.ore.s
';]hbenef.aa.smpb
;]h'rsnmes.ura.sarde

Sz
1KB
LEE
LkE
LKE
LEB
LKB

Type

S Soript File
54, Script Fin
R Pl

A File
SAHPLE File
SAMPLE File

The initdg4msql.ora file is also present in dgdmsql\admin. The initdg4msgql.ora file
contains the connection details that you defined earlier:

B initdgdmsglora - Motepad

Fle Edt Fomab Wew Help

Ld
# HE init parameters
W+

HE_FDE_TRACE_LEVEL=OFF
HE_FDE_RECOVERY _ACCOUNT =RECOVER
HE_FDE_RECOVERY_PwWD=RECOVER

HE_FOE_COMMECT _INFO=10. 148 45 242/ /53l esbemo

# This 1z a customized agent ipdt Tile that contains the HS parameters
# That are needed Tor The Database Gateway for microsoft sqL server

Modify the Oracle Home\NETWORK\ADMIN listener.ora as shown below for the
Listener added. Restart the Listener.
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B listener.ora Malepad

Fle Edt Format  View Help

| Py |

SID_LIST_LISTEMERSQL_FCD =
(SID_LIST =
(SIC_DESC =
SID_MAME=dodmsgl) :
CRAZLE_HOME=D 1 MoracTehproducts 10, 2. 0hdb 1]
PROGRAM=dgdmag 1)

]

LISTENERSM _FCD =
(DESCRIPTION_LIST =
{DESCAIFTION =
CADGRESS_LIST =
(ADDRESS = [PROTOCOL = TCRI(HOST = Tocalhost) (PORT = 15183)

* Modify the tnsnames.ora in Oracle Home \NETWORK\ ADMIN to add the
dg4msq]l details.

P tnsnames.ora - Motepad '._|rﬁ|[§|

Fie Edt Format View Help

(COMNECT_DATA = A
{SERVER = DEDICATED)
CEERVICE_PIAME = BIOTVOT)

J
b
ExXTPROC_CONMECT IOMN_DATA =
(DESCRIPTION =

CLDDRESS_LIST =
(ADDRESS = (PROTOCOL = IPCI{KEY = EXTPROCL))

J

(CONNECT_DATA =
(210 = PLEExXTRroc)
{PRESENTATION = RO)

dgdmsgl =
(DESCRIFTION =
CADDRESS = (PROTOCOL = TCPI(HOST = localhost}(PORT = 1518))
CCONMECT_DATA =(SID = dgdmsql))
. (HE = OK)

e (Create database link in the oracle database:
Create database link <Database link name>
Connect to <"Login"> identified by <"Password">

Using 'dg4msql'
e Database Link name to be used (for running the scripts): GRCM771_APPS_DBLINK
¢ Connect to the SQL database using this database link to load the data.

Using SQL Developer to view the data in SQL server directly from Oracle will result in
errors if the source table contains nvarchar type columns. You can validate the link by
using SQL plus to connect using the database link to the SQL server. Once the data is
loaded in the tables, you can view it using SQL developer.
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Creating the Target Physical Model

Open and compile each of the following package files in the Oracle Client:
Note: Since some of the scripts contain Unicode characters, they might
show errors when opened in oracle clients like SQL developer. To
avoid this, open the scripts in textpad or notepad, then copy and paste
the scripts into the Oracle client to compile them.

¢ Constants_Create_pkg.sql

e Dims_Create_pkg.sql

® Facts_Create_pkg.sql

* Stage_Create_Pkg.sql

Run the following script. This step will create all the physical tables in the target

schema. The caller has the option of forcing the table to be dropped and created based

on value set for v_ForceCreate variable.
It also creates the source stage tables.
Execute_Create.sql

Note: If you are upgrading from an older version of GRCI, please force
create the GRCD_USERS table by setting the value of v_ForceCreate to
"1" while running the Execute_Create.sql (CreateUsers procedure) Else
if the tables already exists (with the structure of Rel 2), DONOT set
v_ForceCreate to "1" i.e. force create the table again as it will lose the
existing data. Recreating the GRCD_TIME_D and GRCD_TIME _TL is
not required if these tables are also present in the database. If recreating
please make sure that the same values of the start and end year are
given.

Run the following script to create the indexes and views in the target schema.

Execute_Index_View.sql

Loading Target Tables

Open and compile each of the following package files in the Oracle Client.

¢ Constants_Load_pkg.sql

e Dims_Load_pkg.sql
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e Facts_Load_pkg.sql

Note: If the GRC Manager web application is not installed on your
machine, you will need to set the v_GRCApplication variable (found in
Constants_Load_pkg) to reference the correct machine/ip address that
is hosting the GRC Manager application.

Note: If the OBIEE installation is not installed on this machine you will
need to set the v_OBIEEApplication variable (found in
Constants_Load_pkg) to reference the correct machine/ip address that
is hosting the OBIEE application.

Run the following script. This step loads all of the tables in target schema.

Note: While running the scripts, to insert data into the stage area, the
variable v_SourceName is to be given as per the source type
(SQLSERCER/ORACLE). If it is an SQL Sever source it should be given
as "SQLSERVER" and for Oracle it should be given as "ORACLE".

Execute_Load.sql

You can repeat this step for several consecutive loads.

Installing OBIEE Reports

Introduction The GRI_20_OBIEE.zip contains two zip files:
¢ GRCDiagnostic.zip

e GRCDWebcat.zip

These files contain the repository and web-catalog, and are used in the steps below to
install the repository and reports-dashboards respectively.

1. After you successfully install OBIEE (OBIEE version 10.1.3.3.3), extract the
delivered zip file GRCDiagnostic.zip. Place the GRCDiagnostic.rpd file in the
C:\OracleBI\ server\Repository folder.

2. In the C:\OracleBI\server\ Config folder, edit the NQSConfig.INI file. Enter the
name of the RPD file after "Star =" in the [ REPOSITORY ] section.

3. Place the GRCDWebcat.zip file in the C:\OracleBIData\web\ catalog folder and
unzip the file. The GRCDWebcat folder now appears in the Catalog folder.

4. In the C:\OracleBIData\web\ config folder, edit the instanceconfig.xml file. Enter
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10.

11.

12.

13.

14,

the path of the GRCDWebcat folder in between the <CatalogPath> tags.
Create the TNS entry to point to your GRCI schema in Oracle home directory.

Open the GRCDiagnostic.rpd in the Oracle BI Administration Tool and go to the
Variable Manager under the Manage > Variables menu.

Update the GRI_DSN variable with the name of the TNS entry name.
Update the GRI_USER_ID with the database user ID.

Open the properties window for 'GRC Diagnostics > GRCI Connection Pool' in the
Physical layer and provide the password for GRCI schema.

Save the changes in the Oracle BI Administration Tool.

Restart the Oracle BI Services.

Log into the OBIEE using this URL: http://<localhost>:<TCPport>/analytics, where
<localhost> is the name of the machine or the IP address where OBIEE is installed,
and <T'CPport> is the Web Site TCP Port number.

The OBIEE login page loads.

The installation is now complete.

Multi-Language Setup for OBIEE

The source language files required to support multiple languages in OBIEE are located
in the GRI_20_GRCM_OBIEE_LANG.zip file.

They are present in the captions.zip file.

Currently there are 11 supported languages:

1.

Danish (da)

German (de)

Spanish (es)

French (fr)

French Canadian (fr-ca)
Italian (it)

Japanese (ja)
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8. Korean (ko)
9. Portuguese Brazilian (pt-br)
10. Chinese (zh)
11. Chinese Traditional (zh_tw)

Follow the procedure mentioned below to include the language files in the OBIEE

server. This procedure must be followed after installing OBIEE and before starting the
OBIEE server.

Note: If the "res" folder is not already present then create this folder in
the "web" folder.

e 1. Unzip the captions.zip file present in the GRCI_20_GRCM_OBIEE.zip file into "
OracleBIData\web\". Check if the folder structure matches as shown below in
Figure 1.

) Crack=BiDats
) aggr
L cache
+ L0 common
) deconnacted
) schedular
() tmp
=i web
# | catalog
—J config
] list=
0] B
1 magdb
= I &g
= |:E5
L Captions
= | | _de
) Caphions

+

+

Figure 1

e 2. Copy the "GRCDiagnostic.xls" file present the GRCDiagnostic.zip to the OBIEE
Server Repository folder. The location is "OracleBI\ server\ Repository\".

¢ 3. Create the System DSN named 'LANGUAGE_POOL' and configure it to point to
the "GRCDiagnostic.xIs" that was copied to the location mentioned in Step 1.

e a) Use the Administrative Tools => Data Sources (ODBC) to create the DSN. Select
the Microsoft Text Driver as shown below in Figure 2.
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Select a driver for which pou want bo zet up a data zounce.

M arne | | A
Adaptive Server Anywhere 9.0 9
Drriver da kicrozoft para arquivos besto [©tek " cev] 4
Drriver do Microsoft Access [*.mdb] 4
Diriver do Microzoft dB ase [*.dbf] 4
Diriver do Microzaft Excel” =l2] 4
4
1
4
4
A

Drriver do Microzaft Parados [*.db ]
Drriver para o Microzaft Vizual FoxPro
Microzoft Access Dnver [*.mdb]

Mizrazaft Access-Treiber [ mdb] ™
RLE RPN FE AD —mm Diriname 1% AR J

™ 2]

Finizh Cancel

Figure 2

e Db) Provide the Data Source Name as LANGUAGE_POOL. Use the "Select
Workbook" and select the "GRCDiagnostic.xls" in the Repository folder that we
copied in step 2.

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for GRCM 7.8  2-21



»
X

ODBC Microsoft Excel Setup

Drata Source Mame: IL&NEU.&EE_F‘DDL 0k, |
Description: I Cemes] |
—Databaze
_ Help |
Version: | |Fucelo72000 v
Workbook! T\ ARepositorphGRCDIaghostic. <ls

Select \Workbook. . |

™| Usze Current Directan

Optiones > |
Select Workbook X
Databasze Mame 1 Directories: 0k |
IGHEDiagnnstic.Hls I :horaclebihserversreposgitony
Cancel |
GRCDiagrostic. =l J = o
[=* OracleBl Hel
[=> server 4||:I
= Repositary ¥ Fead Only
Lizt Filez of Type: Drrives:
IE:-:CE| Files [*.xlz] j I = j Metwark... |
Figure 3

* 4. To confirm your configurations, Open the GRCDiagnostic.rpd using OBIEE =>
Administration. Verify that the DSN specified in the Connection Pool for the
database "LANGUAGE_POOL" is pointing to the "LANGUAGE_POOL" DSN that
we created in Step 2 as shown in Figure 3.
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Comnection Posl - Connectan Peol =0 w it

Figure 4

¢ 5. Once the connection is established you can verify the data by right clicking on the
"GRCDiagnostic.xls" folder in the physical layer of the rpd and select "View Data"
as shown in Figure 5.

+ U GACD_DB
= [ LANGUAGE_PDOL
B} Conneclion Peal
F-E3 Language_Info

Cut Ctrlax
Copy CbrlZ

fark

Set [con...
Cuplicate

Expand &ll

Check Consistency
Phiysical Diagram ¢
Rename

Properties...

Figure 5
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View Data from Tahls “LANGLGE_PODL™ "Larguoge_L.. O 54
[ e o (o= ]
Sow (100 = e starting from 1 = o

ALTUM | LANILIAGE | sessoon &
] Praseriation C stk Assess B TN_fessmsame
Fresertation Tabls fsssssn e CH_frmmnmme
Presentation Column Assess en Ch_Akpasam
Presertation Column fssess n CH_fessmsame
4 Frasertstion Cobamn fAssess an CH_Femsmamme
B Présentstion Cobamn Assess @ CH_Bciga i
5 Presertation Column fssess n CN_fessmsame
T Freserbation C ol fssess en CH_fepmmname
B Prisertation Cobimh Assiss & Ch_fribaain o
A S
Figure 6

Note: If the rows are visible as shown in Figure 6, then the connection
has been setup correctly.

Now after the connection is established using the connection pool, use the Language
drop down list to select the required language before logging in to OBIEE Presentation
Service as shown below in Figure 7. This will display the application in the selected
language.

|_| Oracle Business Inbellgence Log In &

g ORACLE
i .: — BUEINEES INTELLHIENCE
(7 T T
Oracle Business Intelligen
g

Please enber your Liser I 2nd Passaword bedowy, and then press the Log In button

User ID
Password
Login |

Seleck s Languagd | Ergich
w scln Butiracs Irsigarc] 1| C28Y
danzk

decnrgdation of the Progle suomi
redupardanily craated sohfue frangais

Figure 7
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Installing Bl Publisher Reports
BI Publisher Installation

Install Oracle BI Publisher (10.1.3.3.3). Use the Basic installation option that provides
OC4J, Sun JDK, with BI Publisher. Refer the 'Oracle Business Intelligence Publisher
Installation Guide' for environment requirements and other details.

Data Source Configuration

Connect to BI Publisher server. Go to 'Admin > JDBC' tab. Click 'Add Data Source' link.
The following window appears.

%} Oracle BI Publisher - Microsoft Internet Explorer

| Fie Edt Wiew Favoites Tools Help
| depack = = - D [5] 4| Dseach Egravoites Fmeda OF | - S W - - o
J.\I.Q:Imss |a_‘] H:tp:,I'.I'dhl:p-an'-er--:svpn-g.uL-HI-114-65-66.-.-pn.ua:ls.:nm:??ﬂﬂ,l‘nnlpsarvur,fj G “lﬂﬁ 'I mosnagn  [E

ORACLE Bl Publisher Enterprise

Welcome,
administrator Pref

Reports | Schedules

Admin > JOBC > Add Data Source

Add Data Source

General
* Data Source Hame |
* Conrection String :J
LI -
® Lsarname

|
Password |
* Datsbase Driver Class |

(Enarrgle; orscle jdbe.denver O geleliriver )
[ Uz Prosy Authentication

Test Connection
|&] pane [ [ i wocalintranet

a L

Figure 8

Enter the following information as given below. Use the appropriate connection
information for the content in the <> brackets.

Data Source Name: GRCD

Connection String
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Reporting DB Platform Connection String

Oracle jdbc:oracle:thin:@<host name>:<port
num>:<service name>

Driver Name

Reporting DB Platform Driver Name

Oracle oracle.jdbc.driver.OracleDriver

Click the 'Test Connection' button to check the successful connection establishment.
Then click 'Apply’ button to save the data source connection information. Refer to

Figure 9.

[&1 Oracte 01 Pubtisher - Micrusaft Intermet Explorer ===
Fla b vew Favrdes Teds e ' w
d{%’,f ] B € e frrees @3- 5 @ ﬁﬁﬂ

Sachess | ] bt ffloaner-ksteer TTH amipsenverser st indmidatasounce iupdabeconrectionTmode s CALATE B ypes it ﬂ G

DE CI_.E‘ Bl Publisher Enterprise

Ve o, achiminisirator

Al Data Source
Carcel
Gemeral
* Data Souros Mane  (GROD
* Connaction SNG |y oeacks -0in: @00, 176,150, 133 1521 oec]
" Lkamane gl
Pasword  wew
* Datsnass Drver Clins  oracks o driver, O scieDrser
[Exarspla: or sch b drtewr CracisDeiear |
|:|U:|:' Froey Authentication
Test Conneciion
Seourity
Avadalsles Frobes Alkreand Bk
Ml
= & L
.
Figure 9

Report Configuration

* Stop the BIP Service.

e Extract the delivered zip file GRCI_20_GRCM_BIP.zip.
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e 3. Extract the BIP_Reports_base.zip and BIP_Reports_lang.zip into the same "
Reports" folder. Copy the folders under "Reports" folder to the report metadata to
the directory <Oracle BI Publisher Home>\xmlp\XMLP\Reports\. Refer to Figure
10

=101
| e Edt View Favorkes Tools Hep
| eapack » = - [i] Pysearch | AFoiders (B & W X w2 | EE-
| Address [ C:\ovarome _1pmiplaMUPiReports =] @ao
Falders ®(L 2 ed | Mame |[ Tvpe | Modified
= smi -] I L _lAssessment Repotts EileFol...  3faf2007 ¢
| =120 e e Claudi and Frocess Test Reports FileFal... 9/9/2007 ¢
B Admin Reports ) certification Regorts File Fol... 9/af2007 ¢
2] DemoFies centraks Reports FileFol... 9/3fz007"
1 META-INF Sedect an item to view ks description. | _] Issue Reports Filz Fol... @/8f2007 !
[# ‘=3 Reports oyt T'IstkNaps FileFal... 93jz007 ¢
] Toals T DCII:L;TIBI'H —J Risk Reparts Fibe Fal,.. 9/9r2007 1
| =] Wsers by Bistuwark: FA
i =0 g _J Iy Computer
i W20 pdfaas
-0 Perd
i E 1 persona
2} I_] Program Files
i B{es
| 2] Sisbelanalytics =
o S <| o
|7 obiect(s) (Disk free space: 8.51 GB) D bytas = vy Computer y
Figure 10

e Restart the service.

* Connect to BI Publisher Server. Go to 'Reports' tab and check if the following report
folders are available as shown in Figure 11:

* Assessment Reports

* Audit & Process Test Reports
¢ Certification Reports

e Control Reports

* Issue Reports

* Risk Maps

* Risk Reports
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Figure 11

Security Integration with GRCM (Optional)

This section provides details on integrating the security component of two applications:
GRCM and GRCI to satisfy the following requirements:

1.  All GRCM users available in GRCI , without the need to recreate them.

2. Ability to launch a GRCI dashboard from GRCM application without having to
sign-on.

3. Ability to launch a GRCI answer from GRCM application without having to
sign-on.

The ideal solution to satisfy the above requirements would be to integrate GRCM and
GRCI using the combination of LDAP (Light weight directory access protocol) and SSO
(Single sign-on) servers. This solution provides a quick fix to integrate the security
component of the two applications using the 'External Table Authentication' feature of
OBIEE (Oracle Business Intelligence Enterprise Edition) and it can be used in
implementation sites, which do not have LDAP and SSO.

1. Create and load table to store GRCI users.

The procedure to load the table GRCD_Users is executed as part of the GRCD data load
and it reads data from the GRCM tables Users and UserSecurity Attributes. After the
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load is complete, all the GRCM users and roles are available in the table GRCD_Users,
which then acts as an identity store for GRCI. As rows (which represent users and roles)
are created in the table a proxy password of Password' is used.

* All users are assigned a default password of Password', which is stored in
clear-text form in the table GRCD_Users. During implementation, OBIEE
administrator can change the password as desired but it can be stored only in
clear-text form and all users must have the same password.

e Since the table GRCD_Users also stores user information related to AACG users, it
contains users from both GRCM and AACG, identified by the SRC_SYS_ID column.

The procedures CreateUsers and LoadUsers load data into table GRCD_USERS if
GRCM and GRCI are implemented in Oracle environment.

2. Modify the rpd (The GRCI repository data file) file to create Initialization block
and session variables.

This section begins with modifications to the configuration file and proceeds to create
the initialization block script and session variables in the repository (rpd) file. OBIEE
uses this script to set the session variables when user launches the GRCI
answer/dashboard from GRCM.

1.  Shutdown Oracle BI Server and Oracle BI Presentation Server services.

2. Launch Oracle BI Administration tool. Open the rpd file (indicated in
NQSConfig.ini ->[Repository] section -> Star entry) in offline mode.

3. From the Manage menu, click on Variables to launch the Variable Manager.

4. From the menu click on Action, Select New and choose Session->Initialization Block
to create an initialization block. Name the block as GRCD Security.

5. In the Data Source section, click on Edit Data Source. From the Data Source Type
drop-down box choose Database. In the 'Default Initialization String’ window type
the following SQL:

SELECT USERNAME, GROUPNAME, DISPLAYNAME, LOGLEVEL
FROM GRCD_Users
WHERE USERNAME=""USER'
AND PASSWORD="PASSWORD'
6. The Connection Pool should display 'not assigned'. Click on Browse to launch the

Select Connection Pool window. Click on the appropriate Connection Pool and click
Select, then click OK.

7. In the Variable Target section, click on Edit Data Target. Click New to launch the
Session Variable window. In the name box enter USER. Click OK. Accept the
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'special purpose’ prompt by clicking on Yes.

8. Similarly add variables GROUP, DISPLAYNAME, LOGLEVEL, assigning the
GRCD Security as initialization block to all of them. Add a default initialization
value of 2 for LOGLEVEL variable.

9. Enable the Required for Authentication’ check box.
10. Save the initialization block GRCD Security.

3. Create repository groups corresponding to GRCM roles and secure presentation
layer catalogues.

The GRCM roles are loaded by the sql script into the GRCD_Users table
(GROUPNAME column). Use these roles to create repository groups in the rpd files and
associate only the presentation catalogues that need to be accessed by these roles. So,
when you connect to the dashboard, only the presentation catalogues that are attached
to the user's role are available as 'Subject Areas' for creating answers.

Note: The GRCM role SOAExternalAudit and the presentation catalog
GRC Diagnostics Detail are used as examples in the next section.

1. Open the GRCM rpd in OBIEE Administration tool and logon with admin
privileges.

2. Click on Manage->Security from the menu.

3. On the Security Manager window, select Groups in the left pane and click on
Action->New->Group.

4. From the GROUPNAME column of the GRCD_Users table, select a group (for
example, SOAExternal Audit) and enter that as name of the group. Click OK. The
group is created in the repository.

5. To secure a catalog in presentation layer by the group, right click on the catalog
(GRC Diagnostics Detail), click Properties and click on Permissions tab.

6. In the Permissions window, make sure that 'Show all users/groups' check box is
selected. Locate the group that was added in Step 3 and below the Read' column
click on the check box until it becomes a tick mark, granting access to the
(SOAExternal Audit) group.

7. Right click on another catalog (GRC Diagnostics Overview), click Properties and
click Permissions tab.

8. In the Permissions window, make sure that 'Show all users/groups' check box is
selected. Locate the group that was added in Step 3 and below the Read' column
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click on the check box until it becomes a red x mark, preventing access to the
(SOAExternal Audit) group.

Upon completion of steps 6 and 8, the group SOAExternal Audit has access to GRC
Diagnostics Detail subject area but not to GRC Diagnostics Overview subject area.
(The names of groups and presentation catalogues/subject areas are used as
examples here).

10. Click OK. Save the rpd.

4. Create presentation catalog group and secure dashboards, folders and answers

The GRCM roles are loaded by the sql script into the GRCD_Users table
(GROUPNAME column). Use these roles to create presentation catalog groups and
associate dashboards to each group. So, when the user launches a GRCI
report/dashboard from GRCM, only the dashboards associated with the user's role will
be displayed. No other dashboards can be accessed by the user.

1.

Connect to OBIEE Presentation server and log on as Administrator.

Click on Settings->Administration and select 'Manage Presentation Catalog Groups
and Users' and click on 'Create new catalog group'.

Enter the group name from GRCD_Users. GROUPNAME column, in the Group
Name, Dashboard Name and Dashboard Builder columns of the Create Catalog
Group screen. (For instance, use SOAExternal Audit).

OBIEE creates a folder under 'Shared Folders' and an empty dashboard with the
name specified in Step 3.

Repeat Step 3 until dashboards and presentation service groups are created for all
GRCM roles.

Click Finished and return to Oracle BI Presentation Services Administration screen.
Click on 'Manage Interactive Dashboards' to verify the list of all the dashboards.
Click Finished. Similarly click on 'Manage Presentation Catalog' to verify that the
new presentation service groups appear as folders below Shared Folders. Click
Finished. Click Close Window.

In the 'Answers' screen create desired reports (or move the existing reports) and
store them below the folders created in Step 3.

Edit the dashboards created in Step 5 and add desired reports created in Step 6 to
the dashboard sections.

To prevent/grant access to other dashboards, click on Settings->Administration and

select 'Manage Interactive Dashboards'. The Manage Dashboards screen launches
with a list of dashboards. Choose the dashboard that needs to be secured from the
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role (SOAExternal Audit). Click on the Permissions icon in that dashboard and
remove the public role 'Authenticated Users' from the list of users and groups that
have explicit access to this item. Repeat this step for all dashboards that need to be
secured from the catalog group (SOAExternal Audit). Similarly to grant access to a
dashboard (for the GRCM role), choose the dashboard, click on Permissions icon in
that dashboard and add the presentation service group to the list of users and
groups that have explicit access to this item. At the end of this particular step the
list of dashboards that can/cannot be accessed by the presentation service group is
fixed.

10. To secure Folders and Answers, click on Settings->Administration and select
'Manage Presentation catalog'. The Manage Catalog screen launches with folders.
Switch to Shared Folders. To secure a folder, click on the Permissions icon of the
folder. Remove 'Everyone' from the list of users and groups that have explicit access
to this item. Add only the presentation service group that should have access to the
list of users and groups that have explicit access to this item. Click Finished when
necessary folders have been secured. Similarly to secure a particular answer, click
on the folder name that contains the answer. To secure an answer, click on
Permissions icon of the answer. Remove 'Everyone' from the list of users and
groups that have explicit access to this item. Add only the presentation service
group that should have access to the list of users and groups that have explicit
access to this item. Click Finished when necessary answers have been secured.

11. Logoff and restart OBIEE services.

12. Log on as a GRCM user (associated with SOAExternal Audit role for instance) into
GRCD. Only the dashboards that are accessible to the presentation services group
associated with the GRCM user should be displayed and the user shouldn't have
access to any other dashboard. Click on Answers. Only the folders and answers that
are accessible to the presentation services group associated with the GRCM user
should be displayed and the user shouldn't have access to any other folder or
answer.

5. Modify menu.aspx file to launch GRCD from GRCM menu

This section describes the modifications to be made to menu.aspx, which can be located
in the \Inetpub\wwwroot\ OracleGRCManager\ Nav directory. These modifications
enable the OBIEE based GRCI dashboard to be launched within the GRCM (FCD)
application.

Add the following functions to the JavaScript section of the menu.aspx file:
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function CBIEE redirect{)

{

parent.frames["main'].location.href="<(=mConfig.Constant ("ADVEEPORTINGEASEURL") %
>/8aw.dll?DashboardeNQIV]1=24523452345235cNQ0VE=24523452345235sNUser=<¥=n5tate.Loginlds
:-&NgPasswcr\d:Passtr\d" 5

aelf._status = "";

b

function click()

{

if (event.button = 2){

return false;

i

I

and just before the end of the JavaScript block add these two lines of code:

document.onmousedown = click;
document ..oncontextmenu = new Function("return false®™);

Locate the section:

<tr id="mnuAdvEeporting™ runat="server">

<td class="t-vspacer”></td>

<td class="VNLevel2"><img arc="../images/bullec.gif" alt="bullet™/>inbap;
<a href="<%=mConfig.Constant ("ADVEEPCRTINGBASEURL")%>/saw.dll?Dashboard

</td>
<td class="t-vapacer”></td>
</Lr>

and modify the section as:

<tr id="mnubkdvReporting™ runat="server">

<td clasa="t-vapacer" >/ td>

<td class="VNLevel2"><img src="../images/bullet.gif" alt="bullet"/>&nbsp;
<A href="javascript:0BIEE redirect({);"/>

<ftd>
<td class="t-wvspacer"></td>
</tr>

As seen above, the function of OBIEE_redirect() contains a proxy password of
'Password’, the same as referred to in 'Create and load table to store GRCD users'
section of this document. If you change the password in GRCD_Users table, it should
also be modified in the function OBIEE_redirect().

Save the menu.aspx file.

6. Modify the GRCI views to include a JavaScript call to GRCM pages so that drill
from GRCI to GRCM happens seamlessly

The drill across from GRCI to GRCM (drill back to source) is available out of the box
and this section helps by making that experience seamless.
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Note: This section is only applicable in situations where the GRCI
dashboard is launched from GRCM. If the GRCI dashboard will only be
launched external to GRCM (for instance, by launching the GRCI
dashboard URL directly) this modification to the procedures is NOT
required.

GRCI dashboards like Certifications have links to GRCM which provide insight on the
source data. For instance, the answer 'Assessments - Completion Due Date' which is
available in the Certifications dashboard contains a column called Process Title which
acts as a link to the process information in GRCM. When this column is clicked, the
process page in GRCM is launched with details of the process, within the same frame
(without the need to switch to another GRCM window), thus providing better user
experience. When the browser's back button is clicked the context switches back to the
GRCI dashboard. This section describes the steps involved in updating a URL column
in a GRCI view with a JavaScript call, which provides this functionality.

Note: The steps below explain how to add the JavaScript call to the
view GRCD_PROCESS_V only and it uses the document type
SOA_BPC. Repeat the steps for the views GRCD_ASSESSMENT_V,
GRCD_CONTROL_V, GRCD_ISSUE_V, GRCD_CONTROL_TEST_V
and GRCD_RISK_V using the appropriate document type.

e Edit the view GRCD_PROCESS_V in query editor or open the file that contains the
procedure in a query editor.

e If the environment is MSSQLServer, locate the column:

"<a href=""+b.URL+' /Hav/Redirect.aspx?doctype=50A BPCsid="+a.dDocName+'™>"+a.Title+"</a>" URL,

and modify it to:

‘<a href="javascript:window.top.location="""+b.URL+'/Nav/Redirect.aspx?
doctype=50A BPCiid="+a.dDoclame+'"";">"+a.Title+"</a>' URL,

e [f the environment is Oracle, locate the column:

*<a href="'+b.URL+'/Nav/Redirect.aspx?doctype=50A_BPCsid="+a.dDocName+'™>"+a.Title+'</a>" URL,

and modify it to:

'¢a href="javascript:window.top.location="'"||b.URL||"/Nav/Redirect.aspx?
doctype=50A BPCsid="||a.dDocName||""';">"|la.Titlel | "</a>" TURL,

and remember to use SET DEFINE OFF to suppress the substitution variable, if you are
using an editor like SQL*Plus.
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1. Drop and recreate the view. Save the file.

7. Launch GRCM, switch to GRCI, drill back to GRCM

1. Login to GRCM application and locate the Dashboard link beneath Advanced
Reporting menu item in the left pane and click on it to launch the GRCI dashboard
in the right side frame.

2. The GRCI dashboard will launch with an empty home page, list of dashboards the
role(s) associated with the user id can access ( this was setup in previous sections)
will be available in the top of the frame.

3. Click on a dashboard which has links to GRCM (for instance, Certifications) and
click on a report column which appears as a hyperlink (for instance, the column
Process Title in answer Assessments - Completion Due Date) to drill to details of
that column in GRCM. Click the browser back button to switch back to GRCI.
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Installing Oracle Fusion Governance, Risk
and Compliance Intelligence for AACG 8.1.1

Overview

or Later

This chapter describes the steps necessary to install, configure and populate a GRCI 2.0
datastore sourced from AACG 8.1.1. The following section lists some scripts that need
to be executed to create setup tables and load configuration data into the GRCI 2.0
datastore. The subsequent sections cover the installation of ODI projects, OBIEE reports,
and an optional OAM based security integration.

Installing Oracle AACG Scripts

This section lists some scripts that need to be executed in order to create setup tables
and load configuration data. The subsequent sections cover installation of ODI projects,
OBIEE reports, and an optional OAM based security integration.

Steps to run the scripts for creation of the target and config tables. If you are installing
GRC Intelligence Release 2.0 for GRC Manager and AACG, then AACG Scripts
Installation should be completed first, followed by the GRC Manager Scripts
Installation.

Execute the scripts provided in the following order:

Note: Since some of the scripts contain Unicode characters, they might
show errors when opened in oracle clients like SQL developer. To
avoid this, open the scripts in textpad or notepad, then copy and paste
the scripts into Oracle client to compile them.

1. CreateTable.sql:
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Drops and recreates the target tables, along with the sequences and index.

2. CreateConfigTables.sql:

Drops and recreates the configuration tables.

3. InsertData.sql:

Inserts (-1/-2) rows into dimension tables and also loads the seed data into the
config tables (GRI_A_LOOKUP, GRI_A_LOOKUP_TL, GRI_A_DW_CONFIG_TBL
and GRI_A_SRC_SYSTEM_INFO)

Note: When GRCI-AACG security integration implementation is
required, update AACG host and port information in
SOURCE_URL column of GRI_A_SRC_SYSTEM_INFO table. Use
SET DEFINE OFF to suppress substitution value.

4. CreateTIME.sql:

Time create table package.

5. InsertTIME.sql:

This sql file creates the package ExecuteTIME.sql which loads the Time dimension
GRCD_TIME and GRCD_TIME_TL.

6. ExecuteTIME.sql:

Execute the CreateTIME and InsertTime package to create and insert data into the
GRCD_TIME and GRCD_TIME_TI tables.

7. CreateViews.sql:

Creates the views for the tables.

Installing ODI Code

The following steps describe the process used by ODI to extract the data from the
staging tables populated by AACG data services, and then transforming and loading
the data into GRCI datastore.

1. Create a Master Repository and Work Repository.

2. Create a Physical Connection:

Step 1: Login to the Topology Manager, switch to the Physical Architecture tab:
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I3 Topology Manager [DracleDl Local Repository]
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Step 2: Expand "Oracle" Physical Technologies and Insert a "New Data Server".
Specify the details of the database where "GRI" schema is hosted. (In the JDBC tab
provide the necessary information). Specify the login/privileges that will be used by
the ETL processes.
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oracle jdbcW8Compatible
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Step 3: Once the data server information is saved, specify the "Insert Physical
Schema" in the newly created data server, as shown (specify the "GRI" schema
where GRI_% tables are stored as the physical schema in both Schema and Work
Schema).

b5 vy fs

FeSCHEMAS 30BJECT
PSS CHEMA SOBJECT@WDSERYER

Step 4: Once you have saved the Physical Schema information, you will receive a
Popup message asking for the "Context" for the physical schema, as shown.
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Information

i)

3. Create a Context:

In "Topology Manager", switch to the Context tab, and insert the new context (right
click and insert context), as shown.

4. Create a Logical Schema:

In Topology Manager, switch to the "Logical Architecture” tab, under "Oracle
Technologies" select "Insert Logical Schema", specify the name as "GRI" and choose
the appropriate physical schema (created in Step 1) for the Context created (in Step
2).
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5. Import Model:

Login to Designer, right click on the Models tab. Select Import Model and import
the .xml file supplied, as shown.

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for AACG 8.1.1 or Later 3-7



Import Model... (XML File)

Import Type

[ Synonym Mode INSERT -
File irpoart directory

b:l [3
Zelect the file(s) 1o impart

=Rl

[ (], ] [ Cancel ]

6. Import Project (without child components):

Import the Project file provided with the "INSERT" mode. The project file does not
have any child components.

(XML File) X
Import Type
[ SynomymMade NSERT w]

File irmport directory

proDi_Expart [:]

Select the fil=(s) to import

[ Ol ] [ Cancel ]

7. Import Project Variables:

3-8 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



Import the variables into the project with the "INSERT" option.

Import ¥ariable... (XML File)

Impart Type
[ Synonym Mode INSERT v

File itmport directory
o 10D_Export Export t ARUGRI_20_ODAGRI_20_Common [ ..

Zelect the file(s) to import

[ (], ] [ Cancel ]

8. Import User Functions:

Import User Functions in the "INSERT" mode.

Import User Function... (XML File)

Irmgart Type
[ éynnnym hode INZERT

>
File irmport directory
Pri0DI_Export L)

Zelect the file(=) 1o impoaort

DFLT_FLMS
GRI_MUM_DFLT _FUMC

9. Importing Folders:
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Import the Folders provided (SOD Mart and Global Dimensions) without the child
component using "INSERT" mode.

Import Folder... [XML File)

Impart Type
[ Synanym Mads INSERT w

File irmpart directary
ISmr'rthw.GHCD R2VERI_CDi_ExportysRI_ODI EXPORT OF_25_05 Q

Select the file(=s) to irmport
Global Dirmenzions with child

Glokal Dimensions wwithout child
=00 Mart with child
SO0 hart withiowut child

[r—  r—

10. Import Knowledge Modules:
Right click the imported SOD Mart folder, and select "Import Procedure".

Frojects S B x|
DT W
=I5 GRi
IR | .
I8 TQ Open in Mew Wincow
. "
i Edit ir & Mew Window
- ew
_dInsert
Duplicate
Delete
rport Package .
Expott... Import Sub Folder .,
Export All Scanarios.. Inpeet Pracadire.
Prirt
Yersion L]
Gerarate All Scenarios.,.
| Insert Folder
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Import Procedure... (XML File)

Imgort Type

([ Synidiym hode INSERT -]
File import directory

|p-o0i_Esport @

Select the fila(z) to impart

remental Losd

[ ok ) [ cacea |

Import the "IKM Oracle Merge Dimension Incremental Load" and "IKM Oracle Fact
Incremental Load" supplied, as shown above.

11. 11. Import Folders (with child components):

Import the folders (SOD Mart and Global Dimensions) with the "INSERT_UPDATE
" option.

Import Folder... (XML File)

Impart Type
[ Synonym Mode INSERT_LPDATE v

File itmport directory

b:'lSmr'rthy'LGRCD R2MGR_ODi_ExportVzRlI_EXPORT_O07_07_05 Q
Zelect the file(s) to import

Global Ditnensions with child
lobal Dirmensions without child
=00 Mart with child

SO0 Matt without child

[ (], ] [ Cancel ]
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12,

Once you are done importing, open the imported interface, and make sure that it
does not show any errors.

Installing OBIEE Reports

The GRI_20_OBIEE.zip contains two zip files:

GRCDiagnostic.zip

GRCDWebcat.zip

These files contain the repository and web-catalog and are used in the following steps
to install the repository and the reports-dashboards respectively.

1.

10.

11.

12,

After you successfully install OBIEE (OBIEE version 10.1.3.3.3), extract the
delivered zip file GRCDiagnostic.zip. Place the GRCDiagnostic.rpd file in the
C:\OracleBI\ server\Repository folder.

In the C:\OracleBI\server\ Config folder, edit the NQSConfig.INI file. Enter the
name of the RPD file after "Star =" in the [REPOSITORY] section.

Place the GRCDWebcat.zip file in the C:\ OracleBIData\ web\ catalog folder and
unzip the file. The GRCDWebcat folder now appears in the Catalog folder.

In the C:\OracleBIData\ web\ config folder, edit the instanceconfig.xml file. Enter
the path of the GRCDWebcat folder in between the <CatalogPath> tags.

Create the TNS entry to point to your GRCI schema in Oracle home directory.

Open the GRCDiagnostic.rpd in the Oracle BI Administration Tool and go to the
Variable Manager under the Manage > Variables menu.

Update the GRI_DSN variable with the name of the TNS entry name.
Update the GRI_USER_ID with the database user ID.

Open the properties window for 'GRC Diagnostics > GRCI Connection Pool' in the
Physical layer and provide the password for GRCI schema.

Save the changes in the Oracle BI Administration Tool.
Restart the Oracle BI Services.

Log into the OBIEE using this URL: http://<localhost>:<TCPport>/analytics, where
<localhost> is the name of the machine or the IP address where OBIEE is installed,
and <TCPport> is the Web Site TCP Port number.

3-12 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



13. The OBIEE login page loads.

14. The installation is now complete.

Security Integration with AACG (Optional)

This section describes the security integration between GRCI 2.0 and AACG 8.1.1 or
later.

This section describes how a user logs into GRCI, and can drill-across to AACG to see
more details without having to sign on.

Prerequisites

Installation of AACG version 8.1.1 and GRCI Release 2.0 is required.

Installed Software

*  OBIEE (Oracle Business Intelligence Enterprise Edition) version 10.1.3.3.3 (with
OC4])

® Oracle HTTP Server (Apache 2.0)

* Web server and directory server. (Used here are SUN ONE Web server 6.1 and
iplanet directory server 5.1)

¢  OAM (Oracle Access Manager)10.1.4.0.1
¢  WebGate (OAM Web component) 10.1.4.0.1

For installing and setting up software, please refer to the installation and user guides.
Web server and directory server must be installed prior to OAM installation, as it is a
prerequisite for OAM installation. OAM is installed on some servers, and OBIEE, OHS
(Oracle HTTP Server) and WebGate are installed on the client side.

Steps for Integration
Step 1. Configuring the Access System, Policy and Users in OAM

At least one Access Server must be installed and configured. A policy and AccessGate
should be created for the resource you want to protect. At least one WebGate must be
installed on the client side, and configured to communicate with the Access Server
AccessGate function, and performance can also be configured to respond to their
unique needs.

® In the access system configuration, set up the access server, host identifier, and the

access gate.

* Login into Oracle Access Manager. Go to Access System Configuration -> Access
Server Configuration -> Add In the access server, provide a name, host, port of the
machine where OAM is installed, and the search parameters.
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* Login into Oracle Access Manager. Go to Access System Configuration, on the side
navigation pane, click Host Identifiers -> Add ->Specify a name, description and all
possible identifiers for this host. As a host can be known by multiple names, the
Host Identifiers feature is used to enter the official name for the host, and every
other name by which the host can be addressed by users.

Create Access Gate. On the Access System Configuration page select Add New
AccessGate. Provide a name, host, and port of the machine where OBIEE for GRCI
is installed and other search parameters.

* Login into Oracle Access Manager. Go to Policy Manager -> Create Policy Domain
-> Create a policy for the URL of the resource.

For each policy you create, you can assign a specific authentication scheme (Basic
Over LDAP), an authentication rule, an authorization expression, and an auditing
rule.

* Login into Oracle Access Manager. Go to Identity System Console -> User Manager
Tab -> Create User Identity tab, and create a new user.

When the credentials are asked for to login into GRCI, a username and password
should be entered. This will allow the user to drill down to AACG without having
to log on.

* Below are the steps that describe the flow of the OAM component:

a) User attempts to access web resource (http) on OHS which is protected by Oracle
Access Manager, a request is received by WebGate

b) WebGate requests the policy from the Access Server to see if the resource (URL)
is protected or not

c) If the resource/URL is not protected, the user is returned to the previous page. If
resource/URL is protected, WebGate will ask the user to authenticate

d) Credentials entered by the user, and are validated against the LDAP directory
via the access system

e) After successful authentication, a Oracle Access Manager Single Sign-On cookie
is sent to the user's browser

Note: Refer to Oracle® Access Manager Access Administration Guide
(10.1.4.2.0) for more details.

Step 2. Configuring mod_oc4j for Accessing an Application deployed in OC4J

e The directive Oc4jMount is used to make an Application deployed to OC4J
accessible through OHS via mod_oc4j. This directive can be included in the file
mod_oc4j.conf.

Update mod_oc4j.conf located in C:\OraHome\ ohs\ conf directory
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Add the following lines:

# OHS and ocd] configuration
ocdjmount Sanalytics/* ajpl3://localhost:9704

4 mod_oc4j.conf - Notepad =%

“File Edt Format Vew Hep o

R R B R B B B B R B
# oracle 1AsS mod_oc4] configuration file: mod_ocd].conf
g R SR E A E Y A R AR AR AR A SRR R R E R E R AR R A A S

LoadModule onsint_module modules/ mod_onsint.so
LoadModule ocd4j_module modules /mod_oc4].so

# 0HS and ocdj configuration

ocdjmount Janalytics/* ajpl3://localhost:9704
ocdjmount Sxmlpserver /% ajpl3://localhost %704

<IfModule mod_oc4j.cx

</1fmaocdul ex

< | > |

® Restart the OPMN process by running ons.exe from C:\OraHome_3\ opmn\bin.

Communication between OHS and OC4] uses Apache JServ protocol AJP13

Update protocol="ajp13" in
C:\OracleBI\ oc4j_bi\j2ee\home\ config\ default-web-site.xml

£ Farel vt 1,0 T3

vl gy e vise TP Eerveer w oy S0 KMES Chama- instanoe®

sElneRTE e T AT s mealns or acle comy orackeas Fechem s fwebewile:
10_o. uwr'th.-.;--.-,-. Sl afpld” poct < RR0A" Joplay name = 0CAT 10q § ML 1.3) Delault Wels Site”
vchmm nprenans” L' aches s = .

TR N
afetaurts wabe app sppic ston="olanlt” nanie ="gelaulEWoliApg” | =
! = ilmel)” fnnt et filmaocd) s
"dimall” fosts"f divan"
=iMisoaphdaplerwel' roots" fiMESoaphdaptes -
= |wvereuter_web' load-on-startup ="true®

e aton = javassa’ e = favasse- wob® roote’fjasn’

hcation =" ascontrol” ness s ascotrel” lgad-on- atartup="tron” root=" fam® obs
hoaten «"aaalyties” ness "analyties” load-on- ptartupe"trus” rool="fanabytics’
' BfaMEce" iLese "hlalRee™ bad- on- Blartp " trim” ool fhlalioe® /s
ovel app Sppie st =mmilpsenses’ fess S"Emlpyerver” laad- on- s birtup =" e

Jumilpsesneer | -
: e, Flog ) dalault-web-aocesslag” kt="day” - >

Step 3. OBIEE - LDAP Authentication

Create a new LDAP Server entry in the repository (rpd) for iplanet Directory where
OAM users get stored using the following procedure.

a) To Modify the Repository for User Authentication in iplanet Directory

* Open the rpd in the BI Administration Tool and select Manage > Security from the
application menu.
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® From the Security Manager menu, choose Action > New > LDAP Server.

e In the General tab, enter values for fields as shown in the following example:
Hostname = < iplanet Directory hostname>
Port number = < iplanet Directory port>
LDAP version=LDAP 3
Base DN = < Base distinguished name (DN)>
Bind DN = < Distinguished name required to bind to iplanet Directory >
Bind password = < Password of bind DN>
where the Base DN field identifies the starting point of the authentication search.

If the Bind DN and Bind password entries are blank, anonymous binding is
assumed.
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£ g Securiy Mamne | Description

i Users & 0iM_LDAP

€7 Groups

[% LDAP Servers mrwore—— —

0 Custom Authenticators LDAP Server - OAM_LDAP @
-if Hierarchy

General | Advanced ]

Name: |DAM_LDAP

Hast name: ]infra.vm.oracle.com

i LDAF wersion
Port number: |1 389 i o3
Baze DM: 1dc=\rm,dc=oracle,dc=com
Bind DM: |cn=D irectony Manager

Bind pazsword: ]

Canfirn password: I

Descriptior: Test connection

LOAP Server entry for D&M |

oK | Cancel Help

"OANM_LDAP" TNk

Return to the General tab and click on the Test Connection button to ensure the
connection to iplanet Directory server is successful.

b) Configuring the Initialization Block Used for User Authentication

One initialization block is required for user authentication and to configure it to use
LDAP authentication. It will set the value of USER system session variable.

Create new init block

In the Session Variable Initialization Block window, click on the "Edit Data Source"
button. Select LDAP as the Data Source Type from the drop-down and select the
LDAP Server that was created in above step.

Select the Edit Data Target button. In the System Session Variable window, enter
"USER" in the Name field. Click OK. Click OK when asked to confirm if you want
to use this name.

Test the authentication by clicking on the Test button in the Session Variable
Initialization Block window.
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¢) Configuring the Initialization Block Used to set the GROUP for the User

Note: OBIEE will be not able to recognize nor use any LDAP defined
user-to-group relationships until 11g (or later).

Users are typically assigned to groups via an OBIEE repository session init block using
an external source (E.g. a database table) that contains the user-to-group association.
This init block sets the GROUP session variable.

e Shutdown Oracle BI Server and Oracle BI Presentation Server services
® Launch Oracle BI Administration tool. Open the rpd file in offline mode
* From the Manage menu, click on Variables to launch the Variable Manager

e  From the menu click on Action, Select New and choose Session->Initialization Block
to create an initialization block

® In the Data Source section, click on Edit Data Source. From the Data Source Type
drop-down box and choose Database. In the 'Default Initialization String' window
type the following SQL:

SELECT ROLE_NAME

FROM GRCD_USERS A, GRI_D_ROLE_USER_BG B, GRI_D_ROLE_TL C
WHERE A.USERNAME="USER' AND

A.SRC_SYS_ID="AGS8(

AND A.GRCD_USER_SID = B.GRCD_USER_SID

AND A.SRC_SYS_ID =B.SRC_SYS_ID

AND B.ROLE_SID = C.ROLE_SID

AND B.SRC_SYS_ID = C.SRC_SYS_ID

AND C.LANGUAGE ="'VALUEOF(NQ_SESSION.LANGUAGE_CODE)'

e The Connection Click on Browse to launch the Select Connection Pool window.
Click on the appropriate Connection Pool and click Select, then click OK.

¢ In the Variable Target section, click on Edit Data Target. Click New to launch the
Session Variable window. In the name box enter GROUP. Click OK. Accept the
'special purpose’ prompt by clicking on Yes.

* Enable the Required for Authentication' check box.

e Save the initialization block.

d) Creation of Repository Group and Presentation Catalog Group
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Create a repository group and a presentation catalog group (the same as group that was
assigned in the prior step). For example, if the GROUP has a variable set to Apps
Administrator, then the user creates a repository group, and a presentation catalog
group as "Apps Administrator". This step is needed in order to see the group in the rpd
and the webcat to further secure presentation layer catalogs, dashboards, folders and
answers. A dynamic assignment is done in the prior steps only.

Note: Creation of a group should be done by logging in as an
Administrator to rpd and webcat. This should be done on a different
machine that does not have OAM integration on it. With OAM
integration only, OAM users can log into presentation services even if
they don't have Administrator user privileges.

* Creation of Repository Group

Open the GRCM rpd in the OBIEE Administration tool and logon with admin
privileges

Click on Manage->Security from the menu

On the Security Manager window, select Groups in the left pane and click on
Action->New->Group. Enter a group name that gets assigned to the GROUP session
variable in the prior step.

¢ Creation of a Presentation Catalog Group

Connect to OBIEE Presentation server and log on as Administrator

Click on Settings->Administration, select 'Manage Presentation Catalog Groups and
Users', and click on 'Create new catalog group'

Enter the group name that gets assigned to the GROUP session variable in the prior
step, Dashboard Name and Dashboard Builder columns of the Create Catalog
Group screen

Note: Check Oracle® Business Intelligence Enterprise Edition User
Guide for securing presentation layer catalogs, dashboards, folders and
answers.

Step 4. Configuring BI Presentation Services to Use the Impersonator User
The steps to configure BI Presentation Services are:
a) Creating the Oracle BI Server Impersonator User

¢ Open the BI Server repository file (.rpd) using BI Administration Tool.
¢ Select Manage > Security to display the Security Manager.

¢ Select Action > New > User to open the User dialog box.
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Enter a name and password for this user.

For example, Name = Impersonator and Password = secret.

e (lick OK to create the user.

Make this user a member of the group Administrators.
e Double-click on the icon for the user that was created.

® In the Group Membership portion of the dialog box, check the Administrators
group.

b) Creating Adding Impersonator User Credentials to Oracle BI Presentation Services
Credential Store

1. Open a command prompt window or command shell on the machine where BI
Presentation Services has been installed.

2. Navigate to the directory OracleBI/web/bin.

3. Execute the CryptoTools utility to add the impersonator user credentials to the BI
Presentation Services Credential Store:

cryptotools credstore -add -infile OracleBIData/web/config/credentialstore.xml

4. Supply values for the prompted parameters, as shown:

C:\OracleBI\web\bin>cryptotools credstore -add -infile C:/OracleBIData/web/config/credentialstore.xml
>Credential Alias: impersonation

>Credential "impersonation™ already exists. Do you want to overwrite it? yv/n (v) : v

>Username: Impersonator

>Password: password

>Do you want to encrypt the password? v/n (y): ¥

>Passphrase for encryption:passwordl23

>Do you want to write the passphrase to the xml? y/n (n): n

»File "C:/OracleBIData/web/config/credentialstore.xml™ exists. Do you want to overwrite it? yv/m (y): ¥

¢) Configuring Oracle BI Presentation Services to Identify Credential Store and
Decryption Passphrase

Step 1. Locate the node within the instanceconfig.xml file.
Step 2. Specify the attribute values as shown in the following example.

If the node does not exist, create this element with sub-elements and attributes with
attribute values given in the following example.
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<WebConfig>

<ServerInstancel

<!— pther sectings ... —>

<CredentialStore>

<CredentialStorage type="file"™ path="<path to credentiaslstore.mml>" passphrase="<passphrase>"/>
«!'— pther settings ... —>

</CredentialStore>

<!— pther sectings ... —>

</JerverInstance:

</WebConfig>

After modification, CredentialStore node in instanceconfig.xml file looks as below:

<?xml version="1.0"2>
<WebConfig>
<ServerInstance>

«!— pther settings ... —>
<CredentialStore>
<CredentialStorage type="file™ path="C:/OracleBIData/web/config/ credentialstore.xml™ passphrase="passwordl23"/>
«!— pther settings ... —>
</CredentialStore>

<!=- ogther settings ... =-->
</ServerInstance>
</WebConfig>

d) Configuring BI Presentation Services to Operate in the OAM Environment

1. Open instanceconfig.xml for editing. Locate the <Auth>element. If this does not
exist, create this element, sub-elements and parameters as shown in the following
example:

<!— other settings ... —>

<huth>

<550 enabled="true">

<Paramlist>

<!—— IMPERSONATE param is used to get the authenticated user's username and is
regquired

—

<Param name="IMFERSONATE™ source="httpHeader™ nameInSource="550 UID"™ />
</Paramlist>

</5350>

<fButh>

2. Secure the machines that are permitted to communicate with BI Presentation
Services directly.

This can be done by setting the Listener\ Firewall node in instanceconfig.xml with
the list of HTTP Server or servlet container IP addresses. For example:
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<Listener>

<Firewall>

<Allow address="127.0.0.1"/>
<hllow address="10.111.111.111"/>
</Firewall>

#!—— other settings ... —>
</Listener>

Step 5. Drilldown to source system from OBIEE

e GRI_S SRC_SYSTEM_INFO table is used to store the source instance URL and
component path. SOURCE_URL column stores URL and policy, confilctpath id
store component path for policy and conflict path respectively. Refer to AACG
documentation for populating data for these three columns.

® Create an Initialization Block and Dynamic Repository Variable, which are used to
create the URL for the source system. For every drill to page, a separate Init Block
creation is required.

1. In OBIEE Admin tool open the rpd. Go to Manage->Variables-
>Action->New->Repository Initialization Block.

2. In the Repository Variable Init Block window put init block name.

3. Click on edit data source write a query to get URL and component from
GRI_A_SRC_SYSTEM_INFO table. For conflictpathld drill down the query would
look like the following:

SELECT SOURCE_URL || CONFLICT_COMPONENT
FROM GRI_A_SRC_SYSTEM_INFO
WHERE SRC_SYS_ID = 'AGEQ'

-

¢ Assign a connection pool for this init block. Test the authentication by clicking on
the Test button in the Repository Variable Initialization Block window.

® Select Edit Data Target button. Select New in Repository Variable Init Block
Variable Window. Create a Dynamic Repository variable. Similarly, an Init block
for policy Id should be created.

Similarly, Init block for policyID should be created.

* Create a logical column in the business layer of the OBIEE admin tool and select the
check box for Use existing logical columns as source. Specify the expression from
which the logical column should be derived. Replace the :1 with the dynamic field
value, for multiple parameters use nested REPLACE functions. For example, the
expression for logical column for conflictpathld drill would look like the following:
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Logical Column - Conflict Path ID Link =%

Getieral ] Data Type | o0 ] Levels1

Mame: |Eonflict Path 1D Lirk]

Belongs to Table 1"I3FHI: Diagnostice'""Fact - Conflict Path"

Sort arder colure

!Nl:une Gl Cle ‘

v Llze esizting logical calumng as the source

¢a href=" || REPLACE( ]
WALLEOF"AACG_COMFLICTRATH_FG', 1", RTRIM[ CAST

["GRC Diagnostics'’' 'Fact - Conflict Path'. 'Conflict Path 14" A5
CHARACTER (100" TARGET =rmywir:' | RTRIM[ CAST

["ZRLC Diagnostics' " 'Fact - Conflict Path"Conflict Path [d" AS
CHARACTER (100 I ' A&

D ezcription:

The conflict cath 10 link can be used to dill down to sowrce system for
wigwing conflict path,

k. I Cancel Help

® Create an answer with the logical column as created above and change the data
format as HTML) and run the report.

* '"Save system-wide column formats" and "Save Content with HTML Markup"
privilege should be given to Everyone, which is by default given to Presentation

Server Administrators
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Installation and Upgrade Options for Oracle
Fusion Governance, Risk and Compliance
Intelligence 2.0

Overview

This chapter refers the user to the previous sections of the GRCI 2.0 installation guide
when installing for both GRCM 7.8 and AACG 8.1.1 or later.

Additionally within this chapter, if there is an existing GRCI 1.0 installation and it needs
to be upgraded to GRCI 2.0, then the user should refer to the upgrade section, and
follow the instructions.

Installing Oracle Fusion Governance, Risk and Compliance Intelligence for
both GRCM 7.8 and AACG 8.1.1 or Later

Installing Oracle AACG Scripts

Please refer to Chapter 3, which describes the necessary steps for the installation of
AACG 8.1.1 or later as a source application.

Installing Oracle GRCM Scripts

Please refer to Chapter 2, which describes the necessary steps for the installation of
GRCM 7.8 as a source application.

Installing ODI Code

Please refer to Chapter 3, which describes the necessary steps for the installation of ODI
Code in GRCI.
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Installing OBIEE Reports

Please refer to Chapter 2, which describes the necessary steps for the installation of
OBIEE Reports.

Multi-Language Setup for OBIEE

Please refer to Chapter 2, to view the source language files required to support multiple
languages in OBIEE

Installing Bl Publisher Reports

Please refer to Chapter 2, for instructions on installing Oracle BI Publisher 10.1.3.3.3 and
data source configuration.

Security Integration with GRCM 7.8

Please refer to Chapter 2, which provides optional details and requirements on the
integration of the security components for both GRCM 7.8 and GRCI 2.0.

Security Integration with AACG 8.1.1

Please refer to Chapter 3, which provides optional details and requirements on the
integration of the security components for both AACG 8.1.1 or later and GRCI 2.0.

Upgrading GRCI 1.0 to GRCI 2.0

Overview of GRCI 1.0 Data Load

This section applies to users who are upgrading from GRCI 1.0 to GRCI 2.0. The source
of GRCI 1.0 is solely GRCM, and the data is loaded in a 'truncate-load' fashion. This
means that during every load cycle, data in the GRCI tables are truncated and reloaded
from the source application (GRCM). However, if a user wishes to drop, recreate the
tables, and reload them from the source application, they are able to pass a value of 1 to
the vForceCreate parameter, which would then drop all the objects, recreate them and
then reload them.

Upgrading GRCI 1.0 to GRCI 2.0

In order to upgrade from GRCI 1.0 to GRCI 2.0, users can follow the approach of
recreating the entire schema and reloading it from the source, by using the
vForceCreate as explained.

The parameter's value is set in the file Execute_Create.sql to 1, and when it is set to 1, all
the GRCI objects are recreated and reloaded.
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After setting this variable, refer to Chapter 2 if GRCM 7.8 is the only source application;
or, refer to the beginning of this chapter if both GRCM 7.8 and AACG 8.1.1 are the
sources.

The sections on installing Oracle Scripts contains detailed instructions on the
installation and configuration of the model, ETL and Reports-Dashboards components
of GRCI 2.0.

Please read the note section in "Creating the Target Physical Model" in Chapter 2 for
further information about the upgrade of GRCD_TIME_D, GRCD_TIME_TL and
GRCD_USERS.
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ETL Execution

This appendix covers the following topics:
¢ Execution Sequence
¢ ETL Execution

e Execute a Package

Execution Sequence
Order of Execution for the ETL:
The following packages are placed into a single package (GRI_MASTER_PKG).
1. GRI_DIMENSIONS_PKG

2. GRI_BRIDGE_TABLES_PKG
3. GRI_FACTS_PKG

The order for execution of the Dimensions is as follows:

1. GRLINSTANCE_PKG

2.  GRI_GENERIC_DIM_PKG

3. GRCD_USER_MAIN_PKG

4. GRI_POLICY_PKG

5. GRI_ENTITLEMENT_PKG

6. GRI_ACCESS_POINT_PKG

7. GRI_APPS_USER_PKG
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8. GRI_D_RUN_PKG
9. GRI_EXCLUSION_PKG

Steps 4-8 may be run independent of each other, but the rest should be run in numeric
order.

The bridge tables can be run independent of each other, and these are the packages
present in the GRI_BRIDGE_TABLES_PKG. They should be run after the loading of all
the dimensions.

1. GRI_D_ROLE_USER_BG_PKG

2. GRI_D_ROLE_USER_BG_PKG

3. GRI_POLICY_DETAIL_BG_PKG

4. GRI_D_ENTLMNT_GENERIC_DIM_BG_PKG
5. GRI_D_ENTITLEMENT_AP_BG_PKG

The GRI_FACTS_PKG contains the following packages for loading the conflicts and
conflict paths and they should be loaded in the following order and only after the
loading of the dimensions and bridge tables.

1. GRI_F_CONFLICTS_T_PKG
2. GRI_D_POLICY_PREV_RUN_BG_PKG
3. GRI_F_CONFLICT_PATH_T_PKG

4. GRI_F_CONFLICT PATH_T_PKG_2

ETL Execution

In the ODI Designer module, (N) GRI > SOD Mart > Packages; the user can then locate
the following master package: GRI_MASTER_PKG.

The dimension and bridge table related interfaces and packages are found by
navigating in the ODI Designer module to (N) GRI > SOD Mart.

The fact table and related interfaces and packages are found by navigating in the ODI
Designer module to (N) GRI > SOD Mart > Facts.

There are three ETL Execution options:

Option 1:
1. Execute GRI_MASTER_PKG Package.
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2. This action triggers all the packages required to load the entire star schema.

Option 2:

Important: Execute the packages in the following order.

1. GRI_DIMENSIONS_PKG - this package will load all the dimension tables.
2. GRI_BRIDGE_TABLES_PKG - this package will load all the bridge tables.
3. GRI_FACTS_PKG - this package will load all the fact tables.

Option 3:

Run individual table level packages, in the same order as in Option 2.

Execute a Package

In order to execute a package, navigate to the ODI Designer and locate the required
package to execute

Right click on that package, and then click Execute as shown below:
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In the Execution window, select the context that was created as part of the ODI Code
installation.

Note: Please refer to Chapter 3 "Installing ODI Code"

Click OK. This starts a session for the executed package.
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The status of a session and its corresponding steps and tasks can be checked in, in the
ODI Operator module.

In case of a higher-level package, such as one encapsulating multiple child packages,
the status for each child package session can also be monitored.
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Verify that the package has run successfully. The result of each task execution can be
viewed in the Execution tab of Session Task window.

Verity the number of rows processed as part of each task in the session.

Note: Please refer to the Oracle Data Integrator User's Guide for more
detail on using the ODI Designer and ODI Operator modules.
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Architecture

This appendix covers the following topics:
¢ Data Flow Diagram

¢ Detailed Data Flow Diagram
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Data Flow Diagram
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Detailed Data Flow Diagram
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Logical and Physical Models

This appendix covers the following topics:

¢ Data Flow Diagram

e GRCI- AACG 8.1.1 or later Logical Model
e GRCI- AACG 8.1.1 or later Physical Model
e GRCI- GRCM 7.8 Logical Model

* GRCI- GRCM 7.8 Physical Model

Data Flow Diagram

GRCI - AACG 8.1.1 or later Logical Model

e Conflicts
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Conflict

Grain: Run, Policy, Global User

Conflict Generation Flag
Conflict Status
Latest Policy Run Flag

Approved Conflict Count
Monitor Conflict Count
Pending Conflict Count

Prevented Conflict Count

Rejected Conflict Count

Total Conflict Count

Number of Days Qutstanding
SOD Policy Count
Run Count
Global User Count

Time Series{YAgo, QAgo, MAgo)..

Time hierarchy:
Year -> Quarter -> Manth -> Day

Policy hierarchies:

Policy Type -> Policy Name
Policy Priority -> Policy Name
Process -> Policy Name

Risk -> Paolicy Name

e Conflict Path

Conflict Path

Grain: Run, Policy, Application
User, Instance, Conflict Path
Conflict Generation Flag
Conflict Path Status
Latest Policy Run Flag

Approved Conflict Path Count AT

Monitor Canflict Path Count
Pending Conflict Path Count
Prevented Conflict Path Count
Rejected Conflict Path Count ﬁ" Run
Total Conflict Path Count
Conflict Count

Number of Days Of ing
50D Policy Count ﬁ—' Instance
Run Count

Application User Count
Rale Count
Privilege Count
Entitlement Count
Assigned To User Count

Access Point
(Prbdlege]

{1

{ } .(R"Pcn‘ee.ris Point

A= .

Time Series(YAgo, QAgo, MAgo).
Time hierarchy:
Year -> Quarter -> Month -> Day

Policy hierarchies:

Policy Type -> Policy Name
Policy Priority -> Policy Name
Pracess -> Policy Name

Risk > Policy Name

Access Point hierarchy:
Access Point Type -> Access Point Name

¢ Conflict comparison by Run
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Conflicts Comparison by Run

Grain: Run, Palicy

Conflict Generation Flag
Latest Policy Run Flag
Approved Conflict Count
Monitor Conflict Count
Pending Conflict Count
Prevented Conflict Count
Rejected Confiict Count
Total Conflict Count
Approved Conflict Count (Previous Run}
Monitor Conflict Count (Previous Run)
Pending Conflict Count {Previous Run}
Prevented Conflict Count (Previous Run)
Rejected Canflict Count (Previous Run)
Total Conflict Count (Previous Run)

ale

Approved Conflict Path Count
Moniter Conflict Path Count
Pending Conflict Path Count

Prevented Conflict Path Count

Time hierarchy: Rejected Conflict Path Gount

Year -> Quarter -> Month -> Day Total Conflict Path Count

Approved Conflict Path Count (Previous Run)

Policy hierarchies: Monitor Conflict Path Count (Previous Run)

Policy Type -= Policy Name Pending Conflict Path Count (Previous Run)

Policy Priority - Policy Name Prevented Conflict Path Count (Previous Run)
Process == Palicy Name Rejected Conflict Path Count {Previous Run)

Risk -> Palicy Name Total Conflict Path Count {Previous Run)

e Exclusions
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Exclusions/Conditions

Grain: Exclusion Type, Exclusion
Value, Policy, Instance, Start Date

Condition Start Date

i Generic.

Exglusion/ >

[} B 70
Condition End Date

p— Condition Value Start Date

XClusiol eric i
{ } GondtionT AN Fle Condition Value End Date

Saodler e on Tyee. Global Condition Flag

Global Condition Value Flag
Same Flag (Policy, Global)

Conditions Count
Policy Count
Access Point Count
Application User Count

2

ﬁ" Acoess Paint

Time hierarchy:
Year -> Quarter -> Month -> Day

Policy hierarchies:

Policy Type -> Policy Name
Policy Priority -> Policy Name
Process -> Policy Name.

Risk -> Palicy Name

Access Point hierarchy:
Access Point Type -> Access Point Name

e Path Exclusion

Path Exclusions

Point, Access Point - From, Start

Date

Access Point
(Exlude)

Condition Path Start Date
Condition Path End Date
Condition Path Status

Condition Path Action

Access Point
(From)

Policy hierarchies:

Policy Type -> Policy Name
Paolicy Priority -> Policy Name
Process -> Palicy Name

Risk -» Policy Name

Access Point hierarchy:
Access Point Type -= Access Point Name

¢ Policy Detail
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Policy Detail

[ e |

Grain: Palicy, Detail Type, Access
Point, Policy Effective Date

Policy Count
Entitlement Count lm
Access Point Count
Instance Count
Process Count

Risk Count
Time Series(YAgo, QAgo, MAgo)... ! ﬁ—' Time L—@—s\{ S‘;‘I';_Y Effective

Time hierarchy:

Year -> Quarter -> Month > Day
Policy hierarchies:

Policy Type -» Policy Name
Paolicy Priarity -> Policy Name
Process -» Policy Name

Risk -» Policy Name

Access Point hierarchy:
Access Point Type -> Access Point Name

GRCI - AACG 8.1.1 or later Physical Model

e Access Point
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] GRI_D_ACCESS_POINT_TL GRI_D_ACCESS_POINT

ACCESS_POINT_SID : NUMBER ACCESS_POINT_SID : NUMBER
LANGUAGE : VARCHAR2(4) ACCESS_POINT_ID': NUMBER
INSTANCE 31D - NUMBER INSTANCE_SID': NUMBER

SRC_SYS_ID: VARCHARZ(S) SRC_SYS_ID : VARCHARZ(S)
SOURCE_LANG - VARCHARZ(4) 0-1 | ACCESS_POINT_CODE : VARCHAR2(256)
ACCESS_POINT_MAME : VARCHAR2(256) - ACCESS._POINT_TYPE_CODE : Y ARCHAR2(256)
ACCESS_POINT_DESC : VARCHARZ(1024) ACCESS_POINT_START_DATE: DATE
ACCESS_POINT_TYPE_NAME : VARCHAR2(256] ACCESS_POINT_END_DATE ; DATE
BATCH_ID : NUMBER EFFECTIVE_START_DATE : DATE
CREATION_DATE : DATE EFFECTIVE_END_DATE: DATE
CREATED_BY : MUMBER CURRENT _IND ; \VARCHAR2(1)
LAST_UPDATE_DATE : DATE BATCH_ID - NUMBER
LAST_UPDATED_BY : NUMBER CREATION_DATE : DATE

LAST_UPDATE_LOGIM : NUMBER SPEERDI 1 S _ .|CREATED_BY : NUMBER
| LAST_UPDATE _DATE: DATE
LAST_UPDATED_BY : NUMBER
LAST_UPDATE_LOGIN - NUMBER

«UK» GRI_D_ACCESS_POINT_UK1 : ACCESS_POIN'

Eﬁi GRI_D_ACCESS_POINT_ WL TLIGR] D -ACCESS POINT TL)

B.ACCESS_POINT_SID
B.ACCESS_POINT_ID

TL LANGUAGE
BINSTAMCE _SID
B.SRC_SYS_ID

TLACCESS _POINT_MAME
TL.ACCESS_POINT_DESC
TLACCESS _POINT_TYPE_MAME
B.ACCESS_POINT_CODE
B.ACCESS_POINT_TYPE_CODE
B.ACCESS POINT_START _DATE
BL.ACCESS_POINT_END_DATE
BEFFECTIVE_START_DATE
B.EFFECTIVE_END_DATE
B.CURRENT_IMD

BBATCH_D
B.CREATION_DATE
B.CREATED_BY
BLAST_UPDATE _DATE
BLAST_UPDATED _BY
B.LAST_UPDATE_LOGIN

¢ DPolicy
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] GRI_D_POLICY _TL

POLICY_SID : NUMBER(15, 0)
LANGUAGE : VARCHARZ(4)

SRC_SYS_ID : VARCHAR2(S)
SOURCE_LANG : YARCHAR2(4)
POLICY_NAME : VARCHAR2(258)
POLICY_DESC | VARCHAR2{1024)
POLICY_COMMENTS : VARCHAR2(1024)
POLICY_EXPRESSION : VARCHAR2(1024)
|POLICY_STATUS DESC : VARCHAR2(1024)
POLICY TYPE_DESC | VARCHAR2(1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(1S, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED. BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

{&UKz GRI_D_POLICY_TL_UH : POLICY_SID, L.
| «Fis GRI_D_POLICY _TL_FK1: POLICY_SID

B8 GRIDPOLICY VL I
GDPPOLICY_SD - 1=

GDPPOLICY_D L
GDP.POLICY _WERSION_ID
GDPTL LANGUAGE

GDP.SRC_SYS_ID
GDPTL SOURCE_LANG
GDPTL POLICY_NAME
GDPTL POLICY_DESC

GDPTL POLICY _COMMENTS

PRIORITY
EFFECTIVE_DATE
STATUS_CODE
YPE_CODE

A OIWNER_SID
GDPPOLICY_MODIFIED_BY_SID
GDR EFFECTIVE_START_DATE
GDPEFFECTIVE_END_DATE
GDR CURRENT _IND
GDPBATCH_ID

GDP CREATION_DATE
GDP.CREATED _BY

GDP LAST_UPDATE_DATE

GDP LAST_UPDATED_BY
GDPLAST_UPDATE_LOGIN

Entitlement

GDPTL(GRI D POLICY TL;

ﬁ GDPGRI D POLICY

GRID_POLICY

POLICY_SID : NUMBER(15, 0}
POLICY_ID : NUMBER(15, 0)
POLICY_VERSION_D : NUMBER(15, D)
SRC_SY5_ID: VARCHAR2(S)
POLICY_PRIORITY : NUMBER(15, 0)
POLICY_EFFECTIVE_DATE : DATE
POLICY_STATUS_CODE : VARCHAR2(256)
_TYPE_CODE : VVARCHAR2(258)
POLICY_GVWNER_SID - NUMBER(15, 0)
POLICY_MODIFIED_BY_SID: MUMBER(15, 0)
EFFECTIVE_START_DATE : DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

BATCH_ID': NUMBER{(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_EY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER({15, 0)
<Uk» GRI_D_POLICY_Li1 : POLICY_SID

[ GRLD_POLICY_DETAIL_BG

POLICY _SID : NUMBER(15, 0)
DETAIL SID . NUMBER(1S, 0)

DETAIL _T'FE : VARCHARZ(S0)
SRC_SYS_ID: VARCHAR2(S)

BATCH_D : NUVMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY - NUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE LOGIN : NUMBER(15, 0)
s GRI_D_POLICY_DETAIL_5G_U1 : PO
<Fi= GRIZD_POLICY DETAIL FI1 ; POLIC

[T  GRI_D_POLICY_GENERIC_DIM_BG

POLICY _SID : NUMBER(15, 0)
GEMERIC_DIM_VALUE_SID'; NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)

BATCH_ID': NUVBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED_BY  NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

«Ul» GRI_D_POLICY _GENERIC_DIM__L1 ; POLIC
<FI» GRI_D_POLICY _GENERIC_DIM_F¥1 - POLI

Logical and Physical Models
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GRI_D_ENTITLEMENT WL

[5 GRI_D_ENTITLEMENT_TL

ENTITLEMENT_SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)
SRC_SYS_ID - VARCHAR2(S)
SOURCE_CANG : VARCHAR2(4)
ENTITLEMENT _NAME : YARCHARZ2(256)
ENTITLEMENT DESC : VARCHARZ2(1024)
ENTITLEMENT_STATUS_DESC: VARCHAR
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE ; DATE
LAST_UPDATED_B : NUMBER(15, 0
LAST_UPDATE_LOGIN ; NUMBER(15, 0)

UKz GRI_D_ENTITLEMEMT_TL_U1 : ENTITI

GDE ENTITLEMENT _SID
GDE ENTITLEMENT _ID
GDE ENTITLEMENT _VERSION_ID

GRI_D_EMTITLEMENT

ENTITLEMENT_SID: NUMBER(15, 0)
ENTITLEMENT_ID : NUMBER(15, 0)
ENTITLEMENT _VERSIOR_ID - NUMBER(15,
SRC_SYS_ID T VARCHAR2(S)
ENTITLEMENT _EFFECTIVE_DATE : DATE
ENTITLEMENT_STATUS_CODE : ¥ ARCHAF
ENTITLEMENT_MODIFIED_BY _SID ; NUMBE
ENTITLEMENT_GVWNER_SID ; NUMBER(15, |
EFFECTIVE_START_DATE: DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

BATCH_ID: NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0
LAST_UPDATE DATE: DATE
LAST_UPDATED_B'Y - NUMBER(15, 0)
LAST_UPDATE_LOGIN - NUMBER(15, 0)

UKz GRI_D_ENTITLEMEMNT_U2 : ENTITLEM

"

GDETL LANGUAGE E’T‘ GDETL(GRI D EMTITLEMENT TL:

GDESRC_SYS_D
GDETL SOURCE_LANG

5] GRI_D_ENTITLEMENT_AP_BG

ENTITLEMENT _SID : NUMBER(15, 0}
ACCESS_POINT SID * NUMBER(15, D)
SRC_SYS_ID: VARCHAR2(S)
BATCH_ID". NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE: DATE
LAST_UPDATED_BY ; NUWMBER{15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<tz GRI_D_ENTITLEMENT_AP_BG_UT : E

GRI_D_ENTLMNT_GENERIC_DIM_BG

EMTITLEMENT _SID : MUMBER(1

. 0)
GENERIC_DIM_VALUE_SID ; NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)
BATCH_D: NUMBER(15, 0)
CREATION_DATE - DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE ; DATE
LAST_UPDATED_BY ; NUMBER(15, 0)

GDETL ENTITLEMENT _NAME LAST_UPDATE_LOGIN : NUMBER(1S, 0)
GDETL EMTITLEMENT _DESC

GDETL ENTITLEMENT _STATUS_DESC
GDE EMTITLEMENT_EFFECTIVE_DATE
GDE EMTITLEMENT _STATUS_CODE
GDE EMTITLEMENT _MODIFIED _BY _SID
GDE EMTITLEMENT _CWANER_SID

GDE EFFECTIVE_START_DATE

GDE EFFECTIVE_END_DATE

GDE CURRENT_ND

GDEBATCH_D
GDE.CREATION_DATE

GDE CREATED_BY
GDELAST_UPDATE_DATE

GDE LAST_UPDATED_BY

GDE LAST_UPDATE_L OGIM

alKz GRI_D_ENTLMNT_GENERIC _DIM_L1 < ENTITLE

E‘f GDE(GRI D ENTITLEMENTY |-

e  Generic Dimension
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£ ORID_GENERIC_DIN_VL

[ GRID_GENERIC_DIM_TL

(5] GRI_D_GENERIC_DIM

[E GRI_D_GENERIC_DiM_VAL

[ GRILD_GENERIC_DIN_WAL_TL

GENERIC_DIM_SID : NUMEER(15, 0)
LANGUAGE : VARCHAR2(4)
SRC_SYS_ID: VARCHAR2(S)
SCURCE_LANG : VARCHAR2(4)
GENERIC_DIM_NAME : VARCHAR2(256)
GENERIC_DIM_DESC : \/ARCHAR2(1024)
GENERIC_DIM_STATUS_DESC ! VARCHAR
BATCH_ID : NUWBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN: NUMBER(15, 0

<> GRI_D_GENERIC_DIM_TL_U1 : GENEI

TL(GRI D GENERIC DI TL) | &

GENERIC_DIM_SID : NUMEER(15, 0)
GENERIC_DIM_ID : NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(S)
GENERIC_DIM_TYPE_CODE: VARCHARI( 1
GENERIC_DIM_STATUS_CODE : VARCHAR
INSTANCE _SID : NUMBER(15, 0}
EFFECTIVE_START_DATE : DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND': VARCHAR2(1)

BATCH_ID: NUMBER(15, 0)

CREATION_DATE : DATE

CREATED_BY ! NUMBER(15, 0)
LAST_UPDATE DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE LLOGIN: HUMBER(15, 0}

Ui GRI_D_GENERIC_DIM_U - GENERIC.
&Li» GRI_D_GENERIC_DIM_U2 : GENERIC,

GENERIC_DIM_VAL_SID | NUMBER(15, 0)
GENERIC_DIV_SID : NUMEER(15, 0)
GENERIC_DIM_VAL 1D : NUMBER{15, 0
SRC_SYS_ID: VARCHAR2(S)
GENERIC_DIM_VAL_STATUS CODE: VAR
EFFECTIVE_START_DATE: DATE
EFFECTIVE_END_DATE : DATE

CURRENT IND: VARCHAR2(1)
BATCH_ID - NUMBER{ 15, 0)
CREATION_DATE : DATE

CREATED_BY ! NUMBER(1S, 0)
LAST_UPDATE DATE : DATE
LAST_UPDATED B : NUMBER(15, 0)
LAST_UPDATE_LOGIN : HUMBER(15, 0)

<MKz GRI_D_GEMERIC_DIN_VAL_U2 : GEN,
<t GRI_D_GENERIC_DIM_vAL_U1 : GEN

GRI_D_GENERIC_DIM_VAL VL =

BIGRI D GENERIC DIM VAL)

GENERIC_DIM_VAL _SID : NUMBER(15, 0)
LANGUAGE : VARCHAR2(4)

SRE_SYS_ID: VARCHAR2(S)
SOURCE_LANG | VARCHAR2(4)
GENERIC_DIM_VAL NAME : VARCHAR2(256]
GENERIC_DIM_VAL_STATUS_DESC : YARCH

" BATCH_ID : NUMBER(15,0)

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE: DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<UI= GRI_D_GENERIC_DIM_YAL_TL_U1 : GEl
<Flt» GRI_D_GENERIC_DIM_VAL TL__FI1: C

B.GENERIC_DIM_VAL_SID
B.GENERIC_DIM_SID

B GENERIC_DIM_VAL_ID
TLLANGUAGE

B:SRC_SVS_D

TL.SOURCE LANG
TL.GENERIC_DIM_VAL NAME

5 GENERIC_DIM VAL _STATUS_CODE
TL.GENERIC_DIM_VAL_STATUS_DESC
B EFFECTIVE_START_DATE
BEFFECTIVE END_DATE
B.CURRENT_IND

BBATCH_D

5 .CREATION_DATE

B CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED BY
BLAST_UPDATE_LOGIN

B.GENERIC_DIN_SID :
B.GENERIC_DIV_ID - .
TL LANGUAGE

B.SRC_SYSD

TL SOURCE_LANG [

B.GENERIC_DIM_TPE_CODE |

TL.GENERIC_DIM_NANE /¥ BRI D GENERIC DIM)
TL.GEMERIC_DIM_DESC I

B .GENERIC_DIM_STATUS_CODE

TL GENERIC_DIN_STATUS_DESC

BINSTANCE_SID

B.EFFECTIVE_START_DATE

B EFFECTIVE_END_DATE

B .CURRENT_IND

BBATCH_D

B.CREATION_DATE

B.CREATED_BY

B LAST_UPDATE_DATE

B LAST_UPDATED_BY

B LAST_UPDATE_LOGIN

|ES ILIORI D GENFRIC DIM VAL TL)

e Instance
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] GRID_INSTANCE_TL

INSTANCE_SID : NUMBER(135, 0)
INETANCE_ID NUMBER(15, 0)
LAMGLUAGE : WVARCHARZ(4)
SRC_SYS_|D: WVARCHARZ(I)
SOURCE_LANG : WVARCHARZ(4)
INSTANMCE_MAME : VARCHARZ(1024)
INSTANCE_DESC © VARCHARZ2(1024)
INSTANCE_LOCATION : W ARCHARZ(256)
INSTANCE SCHEMA _MAME : WARCHARZ(

INSTANCE_STATUS_DESC : WVARCHARZ(1:

PLATFORM_TYPE : WARCHARZ(256)
PLATFORM_DESC : VARCHARZ(1024)
BATCH_ID : MUMEER(15, 0
CREATION_DATE : DATE

CREATED_BY : MUMBER({15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : MUMBER(15, 0)
LAST UPDATE LOGIN: NUMBER(15, 0)
UKz GRLD_NSTANCE_TL_U1 : INSTANC

£ GRI_D_INSTANCE VL

BINSTAMCE_SID
BINSTAMCE 1D

TL LANGUAGE
TL.SOURCE_LANG
BSRC_S¥S_ID
BINSTAMCE_CODE

TL INSTANCE_NAME
TLINSTAMCE_DESC
TLINSTAMNCE L OCATION
TLINSTANCE_SCHEMA_MNAME
TLIMSTAMCE_STATUS_DESC
TLPLATFORM_TYPE
TLPLATFORM_DESC
BINSTAMCE _HOST_MAME
BINSTAMNCE_LUSER_MAME
BINSTAMCE PASSWORD
BINSTAMCE_PORT
B.INSTAMNCE_URL
BINSTAMCE_DRIMER
BINSTAMCE_STATUS

B PLATFORM_CODE
B.PLATFORM_VERSION
BINSTAMCE_SYMNC_DATE
B.EFFECTIVE_START_DATE
B EFFECTIVE_EMND_DATE
B.CURRENT _IMD
BEATCH_ID
B.CREATION_DATE
B.CREATED_BY
BLAST_UPDATE_DATE
BLAST_UPDATED_BY
BLAST _UPDATE_LOGIN

4 GRI D_NSTANCE
{INSTANCE_SID : NUMBER(15, 0}

INSTANCE_ID - NUMBER(135, 0)
SRC_SYS_ID: VARCHARZ(S)
INSTANCE_CODE : WYARCHARZ(258)
INSTANCE_HOST_MAME ;W ARCHARZ(2:3¢
INSTANCE_LISER_MAME: VARCHARZ(25E
INSTANCE_PASSWORD : WVARCHARZ(256
INSTAMCE_PORT : NUMBER(15, 0]
INSTAMCE_LIRL : YV ARCHARZ{256)
INSTANCE_DRIVER : WV ARCHARZ(256)
INSTAMCE_STATUS : VARCHARZ({256)
PLATFORM_CODE ; VARCHARZ(256)
PLATFORM_VERSION : WV ARCHARZ(256)
INSTANCE_SYNC_DATE : DATE
EFFECTIWE_START_DATE: DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IMD : WV ARCHAR2(S)
BATCH_ID:: MUMBER(S, 0}
CREATICON_DATE : DATE

CREATED_BY : NUMBER{135, 0}

LAST LIPDATE_DATE : DATE
LAST_UPDATED BY : NUMBER(135, 0)
LAST_UPDATE_LOGIN : NUMBER(13, O}

Lalis GRI_D_INSTANCE_LI2 : INSTAMNCE_IC

UKe GRI_D_INSTANCE_LI1 INSTANCE_S

TLIGRI D INSTANCE TL)
I

E”_‘:‘ BIGRI D' INSTANCE
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¢ Run

i GRI_D_RUN

RUN_SID : NUMBER(15, 0)
SRC_SYS_ID: VARCHAR2(50)

RUN_ID : NUMBER(15, 0}

RUN_DATE_SID : NUMBER(15, 0}
TOTAL_CONFLICTS_CNT : NUMBER(15, 0)
TOTAL_CONFLICT _PATH_CNT : NUMBER(15, 0)
RUN_END_DATE : DATE
EFFECTIVE_START_DATE : DATE
EFFECTIVE_END_DATE : DATE

CURRENT_IND : VARCHAR2(1)

BATCH_ID : NUMBER(15, 0)

CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0}
LAST_LUPDATE_DATE : DATE
LAST_UPDATE_LOGIN : NUMBER(15, 0)
LAST_UPDATED_BY : NUMBER(15, 0)

UKz GRID_RUN_U1 : RUN_SID
=UK» GRI_D_RUN_UZ2 : RUN_ID, SRC_SYS_ID

e User
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(%]
APPS_USER_SID * NUMBER(15, 0)
LANGUAGE ' VARCHAR2(4)
SRC_SYS_ID  VARCHAR2(50)
INSTANCE_SID : MUMBER(15, 0}
SOURCE_LANG * VARCHARZ(4)
DISPLAYY_NANE : VARCHARI(256)
USER_NANE : \/ARCHAR2(258)
FIRST_NARE : VVARCHAR2(256)
LAST_NANE : VARCHAR2(256)
USER_DESC: YARCHAR2(1024)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE DATE : DATE
LAST_URDATED_BY : NUMBER(1S, 0)
LAST_UPDATE OGN : NUMBER(15, D)

UK GRI_D_APPS_USER_TL_U1 : APPS

GRI_D_APPS_USER_VL
BAPPS_USER.SD )
8 GLOBAL USER_SD

6 GLOBAL USER_NAVE

B RELATED_USER_D

TLLANGUAGE E5 TLGRI D APPS USER TL)
L SOURCE_LANG
B.SRC_SYS_ID

B INSTANCE_SID
B IDENTIFYING _VALUES
TL DISPLAT_NANE
TLUSER_NAME
TLFRST_N/
TLLAST NAME

TLUSER DESC
B.USER_START DATE
B.USER_END_DATE

B EMPLOYEE_ID

B APPS_USER_STATUS
TLAPPS_USER_STATUS_DESC
B EFFECTIVE_START DATE

B EFFECTIVE_END_DATE

B CURRENT_IND

B(GR| D_APPS' USER)

6LAST_UPDATED_BY

e Time

] GRI_D_APPS_LSER

GRI_D_GBL_USER

APPS_USER_SID': NUMBER(15, 0)
GLOBAL_USER_NAME : VARCHAR2(256)
RELATED_USER ID : VARCHAR2(256)
SRC_SYS_ID : VARCHAR2(S0)
INSTANCE_SID : NUMBER(15, 0)
IDENTIFYING_\ALLES : VARCHAR2(256)
USER_START_DATE : DATE
USER_END_DATE : DATE

EMPLOYEE D NUMBER(15, 0)
APPS_USER_STATUS | VARCHAR2(256)
EFFECTIVE_START DATE: DATE
EFFECTIVE_END_DATE: DATE
CURRENT_IND: VARCHAR2(1)
BATCH 1D : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_LPDATED_BY : NUMBER(15, 0)
LAST_LPDATE_LGGIN : NUMBER(15, 0)

GLOBAL _USER_SID * NUMBER(15, 0)
GLOBAL_USER_NAWE : VARCHAR2(258)
SRC_SYS_ID - VARCHAR2(50)
BATCH_ID - NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
"|LAST_UPDATE DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

<UKs ORI
<UKs ORI

_GBL_USER_U1 : GLOBAL |
_GBL_USER_UZ: GLOBAL L

Ul GRI_D_APPS_USER_U1 : RELATED_USER |
<UK» GRI_D_APPS_USER_UK1 : APPS_USER_SI

TLLANGUAGE
B.SRC_SYS_ID

7] GRCD_USERS
GRCD_USER_SID : NUMBER(15, 0)
USERID': NUMBER(15, 0
SRC_SYS_ID: VARCHAR2(S)

GRCD_USERS_TL

GRCD_USER_SID : NUMBER(13, 0)
LANGUAGE | VARCHAR3(4)

_Svs SRO_SYS_ID: VARCHAR2(5)
ERNAME : NVARCHAR2(765) SOURCE _ANG : VARCHAR2(4)
GROUPNANE : NVARCHAR2(1500) USER NAME_DESC : VARCHAR2(1024)
DISPLAYNANE : NVARCHAR2 FIRST_NAME : VARCHAR2(256)
PASSINORD : NVARCHAR2(765) LAST_NAME : ¥ARCHAR2(256)
LOGLEVEL : NUMBER(1,0) USER_STATUS_DESC: VARCHAR2(1024)
USER_EMAIL ID_1 ; VARCHAR2(240) 1 * USER ADDR: VARCHAR2(1024)
USER_EMAIL 1D 2 VARCHAR2(240) + BATCH_ID : NUMBER(15, 0)
MOBILE_PHONE : VARCHAR2(80) ! CREATION_DATE : DATE
USER_STATUS : VARCHAR2(SD) CREATED_BY : NUMBER(15, 0)
BATCH_D'* NUMBER(15, 0) LAST_UPDATE_DATE: DATE
CREATION_DATE : DATE LAST_UPDATED_BY : NUMBER(15, 0)
CREATED_B'Y  NUMBER(15, 0) LAST_UPDATE_LOGIN : VARCHAR2(15)
LAST UPDATE_DATE ; DATE

aUK» GRCD_USERS_UK1 : GRCD_USER S

(%5 BIGRCD USERS)

L SOURCE_LANG |
TLUSER_NAME_DESC I
TLFIRST_NAME I

TLLAST_NAME

TLUSER_STATUS_DESC

TLUSER_ADDR
B.USERNANE

B.GROUPNAIE
B.DISPLAYNAME

B.PASSWORD =
=

IL(GRCD USERS TL)

B LOGLEVEL
B USER_EMAIL _ID_1
B USER_EMAIL_ID_2
B MOBILE_PHONE

B USER_STATUS
B.BATCH.ID
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GRCD_TIME_TL

TIME_KEY : NUMBER(30, 0)
LANGUAGE : WARCHAR2(10)

SOURCE. LANG : YARCHAR2({10)
LOCALE WARCHAR2{10)

DAY _NAME : NV ARCHAR2(30)
LAST_DAY _IN_MTH_IND : N\VARCHARZ(3!
MTH_NAME : NV ARCHAR2(50)
QTR_MAME : N\VARCHAR2(50)

HOLIDAY _IMD : NV ARCHAR2(30)
VWKDAY_IND : N ARCHARZ(30)
DAY_ABBREY : NVARCHAR2(90)
MTH_ABBREY : MY ARCHAR2(30)

:E\?j GRCD_TIME_VL TL(GRCD TIME TL)

TL LANGUAGE

TL SOURCE_LANG
TL.LOCALE

BASE CREATE_DT

BASE TIME_DT
TL.DAY_NAME

BASE DAY NER

BASE LAST_UPDATE_DT
TL.LAST_ DAY _IN_MTH_IND
TL.MTH. MAME

BASE MTH_NER
TL.QTR_MAME

BASE QTR_NBR

BASE YR_MTH

BASE YR_MNBR
BASEVWK_END_DT
BASEWK_START_DT
BASE WIK_NBR

BASE DAY_NBR_OVERALL
BASEDAY_OF_WK

TL HOLIDAY_IND
TLAWKDAY _IND
TL.DAY_ABBREY

BASE MTH_NBR_OVERALL
TL.MTH_ABBREV

BASE YR_QTR

BASE VWK_NBR_OVERALL
BASE QTR_NBR_OVERALL

GRCD_TIVE_D

| TIME_KE' : MUMBER(30, 0}
CREATE DT : DATE

TIME. DT : DATE

DAY_NAME : NVARCHAR2({30)
DAY _NBR : NUMBER
LAST_UPDATE_DT : DATE
LAST_DAY_IN_MTH_IND : N\ARCHAR2(3
MTH_NAME - N\ ARCHAR2({I0)

| MTH_NBR : NUMBER

QTR_NAME : NVARCHAR2(I0)
QTR_NBR : NUMBER

YR_MTH : NUMBER

YR_NBR : NUMBER

WK_END_DT : DATE
WWK_START_DT: DATE

W _NBR - NUMBER
DAY_NBR_OVERALL : NUMBER
DAY_OF W : NUMBER
HOLIDAY _IND : N ARCHAR2(3)
VWKDAY_IND - NVARCHAR2(3)
DAY_ABBREY : N\ARCHAR2(90)
{MTH_NBR_OVERALL : NUMBER
IMTH_ABBRE' : NVARCHAR2(30)
YR_QTR : NUMBER
WK_NBR_OVERALL : NUMBER
QTR_NBR_OVERALL : NUMBER

&UK» GRCD_TIME_D_UK1 ; TIME_KEY

¢ AGRole
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GRI_D_ROLE_TL

ROLE_SID : NUMBER(15, 0)
LANGUAGE | VARCHAR2(4)

SRC_SYS_ID: VARCHAR2(S0)

SOURCE_LANG : VARCHAR2(4)

ROLE_MAME : VARCHAR2(258)

ROLE_DESCRIPTION : VARCHAR2(1024) ]
ROLE_STATUS_DESC: VARCHAR2(1024) '
BATCH_ID ; NUMBER(15, 0) .
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE

LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER{15, 0}

«UK> GRI_D_ROLE_TL_U1 - ROLE_SID, LA

&2 GRI_D_ROLE_VL

GRI_D_ROLE

ROLE_SID - NUMBER(15, 0
ROLE_ID : NUMBER(15, 0)

SRC_SYS_ID : VARCHAR2(S0)
EFFECTIVE_DATE ; DATE
ROLE_STATUS_CODE : VARCHAR2(258)
EFFECTIVE_START_DATE ; DATE

(EFFECTIVE_END_DATE : DATE

CURRENT_IND : VARCHAR2(1)
BATCH_ID : NUMBER(15, 0)
CREATION_DATE : DATE

CREATED_BY : NUMBER(15, 0
LAST_UPDATE_DATE : DATE
LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)
«UK» GRI_D_ROLE_U1: ROLE_SID

«UKs GRI_D_ROLE_U2: ROLE_D, SRC_S"

BROLE_SID ‘
BROLE_ID H
TL LANGUAGE {7 BIGRID ROLE)
i
|

BSRC_SYS_ID
TL.SOURCE_LANG

TLROLE_NAME [
TL.ROLE_DESCRIPTION I
TL.ROLE_STATUS_DESC
B EFFECTIVE_DATE |
BROLE_STATUS_CODE

B EFFECTIVE_START_DATE
B EFFECTIVE_END_DATE

B CURRENT _ND
BBATCH_ID

B CREATION_DATE
B.CREATED_BY
BLAST_LPDATE_DATE
BLAST_UPDATED_BY
BLAST_LPDATE_LOGIN

e Conflicts Star

TLIGRI D ROLE TL)

_D_ROLE_USER_BG

ROLE_SID : NUMBER(15, 0
GRCD_USER_SID : NUMBER(15, 0)
SRC_S¥S_ID : VARCHAR2(50)
ROLE_USER_STATUS_SID ; NUMBER(15,
EFFECTIVE_START_DATE : DATE
EFFECTIVE_END_DATE : DATE
CURRENT_IND : VARCHAR2(1)

“|BATCH_ID : NUMBER(15, 0)

CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_B'Y : NUMBER(15, 0)
LAST_UPDATE_LOGIN | NUMBER(15, 0)

«UK» GR|_D_ROLE_USER_BG_U1 : ROLE_
«Fis GRI_D_ROLE_USER_BG_GRI_D_FK
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/[ GRI-D.GBL_USER

[ GRLA_LOOHKUR

| Conflict Status

B3] GRLF_CONFLICTS_A1_V
RUN_SID

RUN_DATE_SID

POLICY _SID

SUM{APPROVED. CONFLICT_CNT)
SUM{MOMITOR_CONFLICT_CNT)
SUM{PENDING _CONFLICT CNT)
SUM{PREVENTED_CONFLICT_CNT)
SUM(REJECTED_COMFLICT _CNT)
SUMTOTAL_CONFLICT CNT)
CONFLICT_GEN_FLAG

;Ff GRI F CONFLICTS T

GRIF_CONFLICTS T

+ RUN_SID - NUMBER(15, 0)

RUN_DATE_SID - MUMBER(15, 0)

GLOBAL_USER_SID : NUMBER(15, 0)

POLICY_SID  MUMBER(15, 0)

CONFLICT_STATUS _SID: NUMBER(13, 0)

1 |5 GRLD_RUN

APPROVED_CONFLICT_CNT : NUMBER{15, 0}
MONITOR_COMFLICT_CNT: NUMBER{15, 0}

" | PEMDING _CONFLICT _CNT » NUMBER(15, 0) 1
FREVEMNTED _CONFLICT _CNT : NUMBER(13, 0) I I

REJECTED_COMFLICT CMT : NUMBER{15, 0)

TOTAL_CONFLICT _CNT : NUMBER(15, 0)

MUM_DAYS_OUTSTAMNDING - NUMBER(15, 03

CONFLICT GEN_FLAG : NUMBER{15, 0)
SRC_SYS_ID: VARCHARZ(S)

BATCH_ID - NUMBER(15, 0)
CREATION_DATE : DATE
CREATED_BY : NUMBER(15, 0)

LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMEER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

] GRLD.POLICY

«UK= GRI_F_CONFLICTS_T_U1 - RUN_SID, GLOBAL

Conflict Path Star

[ GRCD_TIME_D

Logical and Physical Models
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[§9] GRIF_CONFLICT PATH_A1_V

RUN_SID
RUM_DATE_SID o

|POLICY_SD ﬁ - GRLF CONFLICT PATH T
INSTANCE_SID |
SUM{APPROVED_CONF._PATH_CNT)
SUMMONITOR_COMF_PATH_CNT)
SUM{PENDING_CONF_PATH_CNT)
SUM{PREVENTED_COMF_PATH_CNT)
SUM(REJECTED . CONF_PATH_CNT)
SUM{TOTAL_CONF_PATH_CNT)

| CONFLICT_GEN_FLAG

W
| GRI_F_COMFLICT_PATH_T
(B oRiDoApRs:USER L |RUN_SID:NUMBER(15, 0) L
| 1 RUN_DATE_SID : NUMBER{15, 0) ?
USER_SID : NUMBER{15, 0)
POLICY _SID : NUMBER(15, 0)
COMFLICT_PATH_ID : NUMBER(15, 0)
ROLE_SID : NUMBER{15, 0)
* | PRIVILEGE _SID : NUMBER(15, 0}
(i INSTANCE_SID : MUMBER(15, 0) 'v
: | ENTITLEMENT . SID : NUMBER
| ASSIGNED_TO_SID : NUMBER(15, 0)
[ GRLD_ACCESS_PONT | STATUS_DATE_SID : NUMBER(15, 0)
| T = | CONFLICT_PATH_STATUS_SID : NUMBER{15, 0) 5] GRCD_TME D
APPROVED_CONF_PATH_CNT : MUMBER(15, 0) T
MONITOR_CONF_PATH_CNT : NUMBER(15, 0)
PENDING_CONF_PATH_CNT : NUMBER(15, 0)
PREVENTED_CONF_PATH_CNT : NUMBER(15, 0)
REJECTED_COMF_PATH_CNT : NUMBER(15, 0)
TOTAL_CONF_PATH_CNT : NUMBER(15, 0)
NUM_DAYS_OUTSTANDING : NUMBER(15, 0)
» | CONFLICT_GEM_FLAG : NUMBER{15, 0) 1
1 SRC_SYS_ID : WARCHARZ(S) = -
BATCH_ID: NUMBER(15,0) ﬁ GRI_D_RUN
CREATION_DATE : DATE i
CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED.BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN : NUMBER(15, 0)

1 | GRL_D_POLICY

| orop_users %!

|<UK> GRI_F_CONFLICT_PATH_T_U1 : RUN_SID, US|

dlias of Access Point

/[F GRI_D_ACCESS_POINT_ROLE [ GRI_D_INSTANCE

[ GRI_A_Lookup /] GRI_D_ENTITLEMENT

Conflict Path Status

* DPolicy Detail Star
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plGRI O POLICY. DETAIL BG)

pwiGRI D POLICY WLy

(B8] ORI_D_POLICY_DETAL_V

POLICY _SID{p POLICY _SID)

TIME_KEfidl. TIME_KE')

ECCESS_POINT_SID(CASE WHEN p.DE" [ ab(GRl D ACCESS POINT)
ENTITLEMENT _SID{CASE WHEN pDETA

DETAIL_TY¥PE(pDETAIL_TYFE}

EMTITLEMENT _ACCESS_POINT _SID(MYLy

ALL_ACCESS_POINT_SID{CASE WHEN

INSTAMNCE SID{ap INSTANCE_SID)

e(GRI. D EMTITLEMENT AP BG)

;_‘ d{GRCD TIME D3

e  Exclusions Star
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GRI_D_EXCLUSION

EXCLUSION_T¥PE_SID : NUMBER{15, )
INSTANCE SID ; NUMBER{15, 0)
| POLICY _SID : NUMBER(15, 0)
/[ GRID_GENERIC_DIM | * SRC_SVS ID: VARCHAR(S) [ ORL_A_LOOKUP
| 1 SANME_FLAG_SID - HUMBER{15, 0
.................... STARTDATE ; DATE = SEmeTlEg
1 ™1 END_DATE : DATE
BATCH_ID : MUMBER(15, )
CREATION_DATE : DATE
CREATED_BY : NUMBER(1S, 0)
LAST UPDATE DATE: DATE
LAST_UPDATED_BY - NUMBER(1S, )
LAST_UPDATE_LOGIN : NUMBER(15, 0

aUis GRI_D_EXCLUSION_U1:; EXCLUSION

[FH GRI_D_POLICY

[ GRI.D_GEMERIC_DIM_WAL i) GRI_D_EXCLUSION DETAIL

» |EXCLUSION_TYPE_SID : NUMBER(15, 0}
3 {INSTANCE_SID - NUMBER(15, 0)

POLICY _SID : NUMBER(15, 0)
EXCLUSION_VALUE SID : NUMBER(15, 0)
SRC_SYS_D: VARCHAR2(S)
START DATE : DATE
END_DATE | DATE 1
BATCH_ID : NUMBER(15, 0) I
CREATION_DATE - DATE

CREATED_BY : NUMBER(15, 0) 1 [ GRLD_INSTANCE
| LAST_UPDATE_DATE : DATE fiv T
| SRLD_aPRS USER ke LAST_UPDATED_BY : HUMBER(15, 0)
| LAST_UPDATE LOGIN : NUMBER(15, 0)
EXCLUSION. TYPE.SID = -89 «UK» GRI_D_EXCLUSION_DETAIL U1 - EX)
[ GRI_D_ACCESS_FOINT | A

|EXCLUSION_TYPE_SID = -999

Exclusion can be User, Access Point
or Generic dimension valug

e Path Exclusions Star
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GRI_D_ACCESS_POINT

5 GRI_D_ACCESS_POINT_FROM

1

GRI_D_PATH_EXCLUSION

INSTANCE_SID - NUMBER(15, 0)
ACCESS_POINT_SID : NUMBER(15, 0)
FROM_USER_SID : NUMBER(15, 0
FROM_ACCESS_POINT_SID: NUMBER(15, 0
SRC_SYS_ID : VARCHARZ(S)
EXCLUSION_ACTION_SID' ; NUMBER(15, )
EXCLUSION_STATUS_SID: NUMBER(15, 0)
START_DATE : DATE

END_DATE : DATE

BATCH_ID : NUMBER(15, 0
CREATICH_DATE : DATE

CREATED_BY : NUMBER(15, 0)
LAST_UPDATE_DATE : DATE
LAST_UPDATED_BY : NUMBER(15, 0)
LAST_UPDATE_LOGIN ; NUMBER(15, 0)

| alias of Access Point

e Assessments

Assessment hierarchy:
ent type -> i

Title

Process hierarchy:
Process Type -» Process Title

Control hierarchy:
Control Class -> Control Title

e Control Tests

GRI_A_LOOKUP

Exclusion Action

[ GRLA_LOOKUP_EXCLUSION_STATUS 1

alKz GRILD_PATH_EXCLUSION_IH : INSTAN

GRCI - GRCM 7.8 Logical Model

Agsessments

Grain: Assessment, Period, Process, Conlrol,
Risk, Design Result, Operating Result

Due Date
Completion Date
Current Assessment Flag
Design Result Date
Operating Result Date

Assessment Total Count
Cerlified Count

Design Effectiveness
Design Complete Count
Design Failed Count
Design Passed Count
Total Design Count
Design Passed %
Design Failed %
Design Complete %

Operating Effectiveness
Operating Complete Count
Operating Failed Count
Operating Passed Count
Tolal Operating Count
Operating Passed %
Operating Failed %
Operating Complete %

Time Series(YAgo, QAgo, MAga)...

| Exclusion Status (alias of
GRI_A_LOOKUR))

Completion
Date

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -» Level 3 ->
Level 4 -> Level 5 -> Base Level
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Process hierarchy:
Process Type -> Progess Title

Control hierarchy:
Control Class -> Control Title

e [ssues

F_'Risk

Issue hierarchy:
Issue Severity -> lssue Title

Process hierarchy:
Process Type -» Pracess Title

Control hierarchy:
Control Class -> Control Title

e Controls

C-20 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide

Control Tests

Grain: Test, Test Period, Process, Control,
Result

Test Create Date
Test Resull Date
Test Result
Current Flag

Total Test Count
Open Test Count
Closed Test Count
Open Test %
Closed Test %

Total Control Count
Passed Control Count
Failed Control Count
Failed Control %
Passed Control %
Coverage

Time Series(YAgo, QAgo, MAga)...

Issues

Grain: Process, Control, Risk, [ssue

Issue Dale
Due Date
lssue Severity
Issue Status

Assessment Issue Count
Audit Test Issue Count
Process Test Issue Count

Cantrol Issus Count
Process Issue Count
Risk Issue Count

Deficiency Count
Documentation Count
Material Weakness Count
Significant Deficiency Count
Total Issue Count

Time Series(YAgo, QAgo, MAgo]...

() B )

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1-> Level 2 -> Level 3 ->
Level 4 -> Level 5 -= Base Level

Time hierarchy:
Year -> Quarter -> Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1.-> Level 2 -> Level 3 ->
Level 4 -> Level § -> Base Level



Issue hierarchy:
Issue Severity -> Issue Title

Process hierarchy:
Process Type -> Pracess Title

Control hierarchy:
Control Class -> Control Title

Risks

Contrals

Grain: Process, Control

Monitoring Control Count
Key Contral Gount
Secondary Control Count
Subordinate Contral Count

Preventive Control Count
Detective Control Count
Corrective Control Count

Auto Monitoring Control Count
Manual Control Count
Automated Control Count

Multiple Control Count
Daily Control Count
Weekly Control Count
Biweekly Control Count
Monthly Control Count
Quarterly Control Count
Annual Control Count
Other Freguency Control Count

% count of above metrics...

Time Series(YAgo, QAgo, MAga)...

Risks.

B P

Issue hierarchy:
Issue Severity -> lssue Title

Process hierarchy:
Process Type -» Pracess Title

Control hierarchy:
Control Class -» Control Title

Grain: Process, Risk, Control

Risk Rating
Risk Significance
Risk Likelihood
Risk Type

Time Series(YAgo, QAgo, MAga)...

Time hierarchy:
Year -> Quarter -> Month => Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1 -> Level 2 -> Level 3 ->
Level 4 -> Level 5 -> Base Level

{ Risk Create
Date

Time hierarchy:
Year ->Quarter ->Month -> Day

Organization, Account, Cycle, &
Fourth Map hierarchies:

Level 1.-> Level 2 -> Level 3 >
Level 4 -> Level 5 -> Base Level

GRCI - GRCM 7.8 Physical Model

e Account
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i GRCD_ACCOUNT D

ACCOUNT_LVLY - NUMBER II=—| M ik il
ACCOUNT LVLZ2: NUMBER {PROCESSID : NUMBER
ACCOUNT_ VL3 : NUMEBER . ACCOUNTMAPID: NUMBER

ACCOUNT—L"'JLq' ChWUMBER L
ACCOUNT_LYLS . NUMBER 1
LEAF_ACCOUNT_ID : MUMBER

ACCOUNTPATH : NVARCHARZ(1024)

PARENTID - NUMBER

MARID : MUMBER

ez GRCD_ACCOUNT _D_UK1 : LEAF_AL
11

GRCD_ACCOUNT TL

LANGUAGE : NVARCHARZ{10)
SOURCE_LANG : NWARCHARZ{10)
LOCALE » NMWVARCHARZ{10)
DESCRIPTION . MW ARCHARZ(240)

e Cycle
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i GRCD_CYCLE D [ PROCESSFINANCIALMAP

CYCLE LWL : NUMBER(10; 0) PROCESSID : NUMBER(10, O0)
CYCLE_LWLZ - NUMBER(10, 0) FINANCIALMAPID - NUMBER(10, 0)
CYECLE_LWL3 : NUMEER(1D, )
CYCLE LWL4 : NUMBER(10, 0}
CYELE LWLS - NUMBER(10, 0 1
LEAF _CYCLE.ID : MUMBER(10, )
CYCLEPATH : NWVARCHARZ(1024)
PARENTID : NUMBER{10, 0)

MAPID | NUMBER(10, 0}

#UKz GRCD_CYCLE_D_UK1 : LEAF_CYCL

B GRCD_CYCLE_TL

CYCLE ID . MUMBER(10, O}
LAMGUAGE - MYVARCHARZ(10)
SOURCE_LANG - NVARCHARZ(10)
LOCALE : NVARCHARZ(1 O}
DESCRIPTION : WY ARCHARZ(240)

e Fourth Map
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e GRCD_FMAP_D {EH PROCESSFOURTHMAR

FIMAP_LWLT : HUMBER(10, 0) PROCESSID : NUMBER
FIMAP LWL2 - HUMBER(10, 0) FOURTHWMAPID ; NUMBER
FMAP L4L3 : HUMBER(10, 0)

FIMAP_LWLA - NUMBER(10, 0)

FMAP LWLS : NUMBER(0, 0) s

pisazat g sl SN & p—

FMAPPATH : NVARCHARZ(1024)

PARENTID ; MUMBER{10, T)

MAPID : NUMBER(10, 0)

#Kz GRCD_FMAP_D_UK1 : LEAF_FMAP_

] GRCD_FMAP_TL
FMAP_ID : NUMBER

LAMGUAGE : NVARCHAR2(10)
SOURCE_LANG : NVARCHARZ(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NV ARCHAR2(240)

¢ Organization
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e GRCD_ORGANZATION D I[Ff] PROCESSORGAMZATIONMAP

ORGANIZATION_L'L1 : NUMBER(10, 0) PROCESSID : NUMBER(10, 0)
ORGANZATION_LYLZ2 ; NUMBER(10, 0) ORGANIZATIONMARID : NUMBER(10, 0)
ORGANIZATION_L'VL3 : NUMBER(10, 0)

ORGANIZATION_LYLA : NUMBER(10, 0)

ORGANIZATION_LVLS : NUMBER(10,0) |

LEAF_ORGANIZATION_ID : NUMBER(1D, 0 1

ORGANIZATIONPATH : NYARCHARZ2(1024

PARENTID : NUMBER{10, 0)

ellie GRCD_ORGAMZATION_D_UK1 . LE:

] GRCD_ORGANIZATION TL

ORGANIZATION.ID : NUMBER{10, 0)
LANGUAGE : NVARCHARZ(10)
SOURCE_LANG : NYARCHAR2(10)
LOCALE ; MVARCHARZ(0)
DESCRIPTION : NV ARCHAR2(240)

e  Process
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| PROCESS. | B PROCESSTYPE_TL DOCLEVELTYPE TL

1D : NUMBER(10, 0) PROCESSTYPE_ID : NUMBER(10, 0) DOCLEVELTYPE_ID : NUMBER(10, 0)
DID : NUMBER{10, 0y LANGUAGE : NYVARCHARZ(10) LANGUAGE : NY ARCHARZ(10)
DDOCNAME : NV ARCHAR2(30) SOURCE_LANG : NVARCHAR2(10) SOURCE_LANG : NVARCHAR2(10)
TITLE : W ARCHAR2(S0) « LOCALE ; MY ARCHARZ{10) LOCALE : NYARCHARZ{10)
REVISION | NUMBER(10, 0) | DESCRIPTION : N ARCHAR2(S00) DESCRIPTION : N ARCHAR2(S00)

STATE : NVARCHARZ(30)
PROCESSCAWWNER : NV ARCHARZ(100)
TESTOWWNER : NV ARCHAR2(100) i
DEPARTMENTAPPROVER : NVARCHAR2(100) ' B
PRCJECTAPPROYER : NVARCHARZ(100) N !
FIMANCEAPPROVER : NYVARCHAR2(100)
MAREVIEWER : NWARCHARZ(100)
MAEXECUTIVEREVIEVWER : NVARCHAR2{100)

COSOCOMPONENT - NVARCHARZ(30) [ i) COMPLEXITYTYPE_TL | | [F GRCD_SERVERURL
COSOCATEGORY : NYARCHAR2(30) COMPLEXITYTYPE_ID.: NUMBER(10, 0) ! |URL: VARCHARZ(100)
HSYSTEMTYPE - NVARCHAR2(30) LANGUAGE : NVARCHARZ(10) || TYPE: VARCHAR2(100)
ASYSTEMSUBTYPE : NVARCHAR2(30) ! SOURCE.LANG : NVARCHAR2(10)

PROCESSTYPEID : NUMBER(10, 1) . LOCALE MYARCHAR2(10)

PROCESSCOMPLEXITYID : NUMBER(10, 0) | DESCRIPTION : NV ARCHAR2(500) !

DOCLEVELID : NUMBER(10, 0) i ) "

DESCRIPTION : NVARCHAR2(1024) | |

CREATEDATE : TIMESTAMP(E)

REVISIONDATE : TIMESTAMP(E) w

KSOAICPATH : NVARCHARZ(1024)
XSODAACCTCYCLE - NVARCHAR2(1024)
XSOAFINSTMTCAP : NYARCHAR2(1024)
ASOAMAP4DATA : NYARCHARZ(1024)

zPHz PK_PROCESS : ID

[B8] GRCD_PROCESS_V

a CREATEDATE i
& DOOCNAME f8 a(PROCESS L

a.DEPARTMENTAPPROVER

a DESCRIPTION E i =

aDID ! !
cLOCALE :
a DOCLEVELID

DocLevel(e DESCRIPTION)

a FINAMNCEAPPROVER

alb I i
a MAEXECUTIVEREVIEWER 11
a MAREVIEWER | 1
8 PROCESSCONFLEXTYD /R C{COMPLEXITYTYPE TLY /R e(DOCLEVELTYPE TL}
ProcessComplexity(c DESCRIPTION i »

a PROCESSOWNER
aPROCESSTYPED
ProcessType(d.DESCRIPTION)
aPROJECTAPPROVER
aREVISION

a REVISIONDATE

aSTATE

a TESTOWVWNER E": b{GRCD SERYERURL
URL('=a href="" || b.URL || '™Nav/Ret

aTITLE

a XSOAACCTCYCLE
aXSOAFINSTMTCAP
a.XSOAICPATH

d(PROCESSTYPE TL)

e Risk
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RISK 5] RISKPROBABILITYTYPE TL RISKTYPE_TL
ID : NUMBER(10, 0) RISKPROBABILITYTYPE_ID : NUMBER(10, | RISKTYPE_ID : NUMBER(10, 0}
DID: NUMBER(10, 0) LANGUAGE : N'vARCHAR2(10) LANGUAGE : NVARCHAR2(10)
DDOCHAME : MV ARCHAR2(30) SOURCE_LANG : NVARCHAR2(10) SOURCE_LANG : NVARCHAR2(10)
TITLE : NV ARCHAR2(255) LOCALE : MWVARCHARZ(10) LOCALE : MW ARCHAR2(10)
REWVISION : NUMBER(10, 0) DESCRIPTION : NV ARCHAR2(500) DESCRIPTION : NVARCHARZ2(500)

STATE : NVARCHAR2(30)

RISKSIGNIFICANCEID | NUMBER(10, 0)

RISKLIKELIHOODID : MUMBER{10, O}

RISKRATING © NUMBER(10, 0) w w
RISKTYPEID : NUMBER(10, 0)

DESCRIPTION : MVARCHARZ(1024)

CREATEDATE : TIMESTAMP(E)

REVISIONDATE : TMESTAMP(E)

XSYSTEMTYPE : NVARCHARZ{30) |

¥SYSTEMSUBTYPE : NWARCHARZ(30) i

XSOAPARENTID: NV ARCHARZ(30) ' _ RISKEXPOSURET YPE_TL

XSOAPARENTSTARTREVID : NUMBER(10, i RISKEXPOSURETYPE_D : NUMBER{10, 0}
¥SOAPARENTENDREVID : MUMBER(10, 0} ' LANGUAGE N'\,’ARCPAR?H 0) ’
XSOARELATEDDOCREVID : NVARCHARZ( 1 ! SOURCE_LANG : NVARCHARZ(T o

> LOCALE - NVARCHAR2(10)

PK= PK_RISK 1D
AR DESCRIPTION : NvARCHAR2(500)

! [ GRCD_SERVERURL
- P ! URL: VARCHAR2(100)
| TYPE: YARCHAR2(100)

e GRCD_RISK_V.

a.CREATEDATE

a DDOCNAME

a DESCRIPTION
aDID

alb

a REVISION
a.REVISIONDATE
cLOCALE

a RISKLIKELIHOODID
RishLikelihood({c DESCRIPTICN) T
a RISKRATING i
a RISKSIGNIFICANCEID

C(RISKPROBABILITYTYPE TL

RiskSignificance(d DESCRIPTION) t SIRISKTYPE L) Spetpatinn E"_: LObloslb BPRL
aRISKTYPED '

RiskType(e DESCRIPTIOM)

aSTATE

URL{"=a href=" || h.URL || "Naw/Re!

a.TITLE

a.XSOAPARENTEMDREYID

8. XSOAPARENTID
a.XSOAPARENTSTARTREVID
a. ¥SOARELATEDDOCREYID

E‘i iRISKEXPOSURETYPE T

e Control
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[ GRCD_SCOPED_CONTROLS
SCOPEPLANDD : NUMBER(10, 0)
CONTROLID : NUMBER(10, 0)
PLAND : NUMBER(10, 0)
DDOCHAME : NVARCHAR2(30)
DID: NUMBER(10, 0)

INSCOPE : VARCHAR2(30)
DATELPDATED : DATE

@PICs PI{_GRCD_SCOPED_CONTROLS ; S
&FiC» GRCD_SCOPED_CONTROLS_CONT_|

CONTROL

] CONTROLTYPE_TL

[ CONTROLMETHODTYPE_TL

[ COMPLEXTYTYPETL

1D - NUWBER(10, 0)

DID - NUMBER(10, D)

DDOCKANE : NVARCHAR2(30)
TITLE ; NVARCHAR2(255)

REVISION : NUMBER(10, 0)

STATE : NVARCHARZ(30)
COSOCGMPONENT : NVARCHAR2(30)
COSOCATEGORY : NYARCHAR2(30)
KEYCONTROL : HVARCHAR2(30)
CONTROLCLASS : NVARCHAR2(30)

CONTROLTYPE_ID : NUMBER(10, 0)
LANGUAGE - NVARCHAR2(10)
SOURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NYARCHAR2(500)

CONTROLMETHODTYPE 1D NUMBER(10,

LANGUAGE : NVARCHAR2(10)
SGURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NVARCHAR2(500)

COMPLEXITYTYPE_ID : NUMBER(10, 0)
LANGUAGE - NVARCHAR2(10)
SOURCE_LANG : NVARCHAR2(10)
LOCALE : NVARCHAR2(10)
DESCRIPTION : NYARCHAR2(500)

CONTROLSUBCLASS : NVARCHARZ(30)

‘ CONTROLTYPEID : UMBER(10, 0)

CONTROLMETHODID | NUMBER(30, 0)

AUDITTYPE : NVARCHAR2(30)

CONTROLFREQUENCY : NV ARCHAR2(30) [ LA e
TARGETSAMPLESIZE : NVARCHAR2(30) TATURITYTPE_ID - NUMBER(10,0)
WMATURITYASISID : NUMBER(30, 0) L ANGUAGE : NVARCHAR2(1D)
MATURITYTARGETID : NUMBER(3D, 0) SOURCE_LANG : NVARCHAR2(10)
COMPLEXITYID : NUMBER(30, 0) LOCALE - NVARCHAR2(10
DESCRIPTION : NVARCHAR2(1024) DESCRIPTIGN  NVARCHAR2(500)
CREATEDATE : THIESTAMR(S)

REVISICNDATE : TIMESTAMP(8)

HSYSTEMTYPE : NVARCHAR2(30)

XS YSTEMSUBTYPE : NVARCHAR2(30)

XSOAPARENTID : NYARCHAR2(30)

OAPARENTSTARTREVID : NUMBER{(10, 0)

XSOAPARENTENDREV'D : NUMBER(10, 0)

¥SOARELATEDDOCREVID : NVARCHARZ(100)

¥SOARELATEDCONTROLDOCREVID : NVARCH

HSOACONTROLOBUECTIVE : NVARCHAR2(100)

[ ORCD_SERVERURL

URL: VARCHAR2(100)
TYPE : VARCHAR2(100)

<PK PI_CONTROL : ID

{5 GRCD_CONTROLV : | i
aAUDITTYPE + ’
cLOCALE ' | |
a COMPLEXITYID 1 i

ComplextyType(c DESCRIPTION) lecoMEOLTYEE T | 75 dCONTROLVETHODTYPE Ty
a CONTROLCLASS

a CONTROLFREQUENCY -
a CONTROLMETHODID

CortroliizthodType(d DESCRIPTIOl i
& CONTROLSUBCLASS |

3 CONTROLTYPED i
CortrolType(e DESCRPTION)

2 COSCCATEGORY

a COSGONMPONENT

(CONTROL.

- i
2 CREATEDATE {5 Q0MATURTYTYPE TL: C(COMPLEAITYTYPE TL i
2 DDOCNAME 1 i
3 DESCRIPTION :

D

aKEYCONTROL

aMATURITY ASISD

MaturityAsisType(f BESCRPTION)
ETID

a MATURITY TARG 5 HMATURITYTYPE TLy T bGRCD SERVERURL)
Maturty TargetType(g DESCRIPTIOl . M

aREVISION

aREVISIONDATE

asT

ATE
aTARGETSAMPLESIZE
URL(<a fref=""| by URL ||'NaviRed

OACONTROLOBJECTIVE
0APARENTENDREYD
a.XSOAPARENTID

. XSOAPARENTSTARTREVID
2.XSOARELATEDCONTROLDOCRE
2.XSOARELATEDDOCREVID

e Control Test
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[5]  GRCD_CONTROL TEST_D

ID: NUMEER(10, 0)
TEST_ID - NUMBER(10, 0)

D_ID : NUMBER(10, 0)

D_DOC_NAME : My ARCHAR2(30)
D_DOC_TYPE : NVARCHAR2{30}
CONTROL _TEST_TYPE : NVARCHAR2(10)
CREATE_DATE : TIMESTAMP(G)

CURRENT WF_USER ; NvARCHAR2(50)
PROCESS.ID : NUMBER(10, 0)
REVISION_ID : NUMEER(10, 0)
REVISION_DATE : TIMESTAMP(E)

STATE : HVARCHAR2(30)

STATUS : NVARCHAR2(20)

TEST_PERIOD : N ARCHAR2{30)

TITLE : NV ARCHAR2(255)

DESCRIPTION : NVARCHAR2({1024)
CONTROLTYPE : NVARCHAR2(30)
TEST_CVWNER : NVARCHAR2(80)
TEST_TYPE ; MVARCHAR2{30)

TEMPLATE_CONTROL_DOC_IDS : MV ARCH

CONTROL_DOC_IDS : NWARCHARZ2{1024)
SOURCE_ID: WARCHARZ(10)
CREATION_DATE : TMESTAMP(E)
CREATED_BY : WARCHAR2(50)
LAST_UPDATE_DATE : TIMESTAMP(E)
LAST_UPDATED_BY | VARCHARZ({50)
LAST _UPDATE_LOGIN : VARCHARZ{30}

ePHs PK_CONTROLTESTD : ID

Assessment

GRCD_SERVERURL

[URL : VARCHAR2(100)
TYPE : VARCHAR2(100)

[p9] GRCD_CONTROL TEST_V

all

a.TEST_ID

ab. D

aD_DOC_MAME

& D_DOC_TYPE
a.CONTROL_TEST_TYPE
a.CREATE_DATE
a.CURRENT WF_LISER
aPROCESS D

a REVISION_ID

a. REVISION_DATE
a.STATE

aSTATUS
a.TEST_PERICD

a.TITLE

a.DESCRIPTION
a.COMTROLTYPE
a.TEST_OWNER
a.TEST_TYPE
a.TEMPLATE_CONTROL_DOC_IDS
a.COMTROL_DOC_IDS

a. SOURCE_ID
a.CREATION_DATE
a.CREATED_BY
aLAST_LUPDATE _DATE
alAST_UPDATED_BY
alAST_UPDATE_LOGIN
URL{"<a href="" || b URL ||'MaviRedirect

[ a(GRCD CONTROL TEST Dj

b{GRCD SERVERURLY

Logical and Physical Models
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B ASSESSMENT

1D : MUMBER{10, 0}

DID - HUMBER

DDOCHAME : NVARCHARZ{30)

DSTATUS : NWARCHAR2(20)

CURRENTWFUSER - N ARCHAR2(100)

TITLE : MY ARCHAR2({S0)

REVISION : NUMBER(10, O)

STATE : NVARCHARZ(30)

PERCENTCOMPLETE : N ARCHARZ(30)

TESTPERIOD : N ARCHAR2(30)

PROCESSCWNER : NVARCHARZ{100)

REVIEWER : NVARCHARZ(100)

EXECUTIVEREVIEWER : NYARCHAR2{100)
PROCESSCAVWNERCERTGIUESTION | NV ARCHAR2(1024)
PROCESSCWWNERCERTANSWER © NY ARCHAR2{30)
PROCESSCVWNERCOMMENTS : N ARCHARZ(1024)
REVIEWERCERTIFICATIONQUESTION : NVARCHARZ(1024)
REVIENVERCERTIFICATIONANSWER - NVARCHARZ(30)
REVIEWERCOMMENTS : NVARCHAR2(1024)
EXECUTIVEREVIEWERCERTQUESTION : NY ARCHARZ2(1024)
XECUTIVEREVIEWERCERTANSWER : NV ARCHAR2(30)
EXECUTIVEREVIEWERCOMMENTS : NVARCHARZ2(1024)
DUEDATE : TIMESTAMP(E)

SURVEYCOMPLETE : NV ARCHAR2(30)

DESCRIPTION : NVARCHAR2(1024)

CREATEDATE : TIMESTAMP(E)

REVISIONDATE : TIMESTAMP{E)

XSOARELATEDDOCID : MY ARCHAR2(100)
¥SOARELATEDDOCSTARTREYID : NV ARCHAR2(30)
XSOARELATEDDOCENDREVID : NVARCHARZ(30)
XSOAMAREQCOMTROLDOCREVIDS : NVARCHARZ(1024)
XSOAMAOPTCONTROLDOCREVIDS - NV ARCHAR2({1024)
XSOAMARISKDOCREVIDS : NY ARCHARD(1024)
HSOAMATYPE : NV ARCHAR2(100)

PHs PK_ASSESSMENT : ID

Issue

[E5 GRCD_SERVERURL

VARCHAR2(100)
TYPE : VARCHAR2(100)

URL

Eﬁ] GRCD_ASSESSMENT- Y

aCREATEDATE

a DDOCNAME

a DESCRIPTION

aDID

aDUEDATE

a EXECUTIVEREVIEWER

a EXECUTIVEREVIEWERCERT ANSWE
a EXECUTIVEREVIEWERCERTQLEST]
a EXECUTIVEREVIEVWERCCOMMENTS
alD

a PERCENTCOMPLETE

a PROCESSOWNER

a PROCESSCOWNERCERTANSWER

a PROCESSOWNERCERTQUESTION
a PROCESSOWNERCOMMENTS

a REVIEWER

a REVIEWERCERTIFICATIOMANSWER
a REVIEWERCERTIFICATIONQUESTIC
a REVIEWERCOMMENTS

a REVISION

aREVISIOMDATE

aSTATE

a SURVEYCOMPLETE

a TESTPERICD

URL('=a href=" || b URL || '‘Mav/Redire
aTITLE

a CURRENTWFUSER

aDSTATUS

a XSOAMACPTCONTROLDOCREVIDY
a {SOAMAREQCONTROLDOCREVIDY
HSOAMARISKDOCREVIDS
XSOAMATYPE
HSOARELATEDDOCENDREYVID
HSOARELATEDDOCID
HSOARELATEDDOCSTARTREVID

R ]

[E¥ a(ASSESSWENT)

b{GRCD SERVERURL
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3] ISSUE | ISSUESEVERTYTYRE TL ISSUETYPE TL

1D NUMBER ISSUESEVERITYTYPE_ID . NUMBER(10, 0) ISSUETYPE_ID . NUMBER(10, 0)
DID-: NUMBER |LANGUAGE N ARCHARZ2({10) LANGUAGE : N\ARCHARZ(10)
DDOCNAME : NWARCHAR2(30) SOURCE_L ANG - NVARCHAR2{10) SOURCE_LANG @ NVARCHAR2(10)
TITLE : NVARCHAR2(255) LOCALE : NVARCHAR(10) LOCALE : NVARCHAR2({10)
REVISION : NUMBER DESCRIPTION : NVARCHARZ(500) DESCRIPTION : NVARCHAR2(500)

STATE : NVARCHAR2(30)
SEVERITYID : NUMBER(10, D)
ISSUETYPEID : NUMBER{10, 0}

REQUIRESREMEDIATION : N ARCHARZ(3C! w w

ORIGINATOR - NV ARCHAR2(30) [ GRCD_SERVERUAL
{PECTEDCOMPLETIONDATE : TIMESTAMEF, TTm ST S| e il L
PLANDESCRIPTION : MY ARCHARZ(100) 1 URL : VARCHAR2(100)
DESCRIPTION : NVARCHAR2(1024) i TYPE: VARCHAR2(100)

CREATEDATE | TIMESTAMP(E)
REVISIONDATE : TIMESTAMP(E)
X¥SOARELATEDDOCID ; NVARCHAR2(100!
HSOARELATEDDOCSTARTREVID : NUMBE:
¥SOARELATEDDOCEMDREVID - NUMBER| L
XSOAADDLRELATEDDOCID : MVARCHARL ™
X¥SOMADDLRELATEDDOCSTARTREVID @ N:
HSOAADDLRELATEDDOCENDREVID - NUK.
¥SOARCOTID : NVARCHAR2(30)

P PK_ISSUE : ID Eﬁ] GRCD_ISSUE_Y 1 2 |

a CREATEDATE | | X

:_EE@%Q{EN alISSUE) ClISSUETYPE TL)

aDiD

a EXPECTEDCOMPLETIONDATE

alp

dLOCALE

alSSUETYPED

IssusType(c DESCRIPTION) |

2.0RIGINATOR i !

2 PLANDESCRIPTION |

a REQURESREMEDIATION

aREVISION

aREVISIONDATE

aSEVERITYD

IssusSeverity(d DESCRIPTION)

aSTATE

URL{'<a href=""| b URL || "NaviRedirect

aTITLE
¢SOAADDLRELATEDDOCENDREYID

OAADDLRELATEDDOCID

OAADDLRELATEDDOCSTARTREV

OARELATEDDOCENDREYID

OARELATEDDOCID

aXSOARELATEDDOCSTARTREVID

dISSUESEVERITYTYPE TL: 5 bIGRCD SERVERURL!

=

Time
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GRCD_TIME_TL
ITIME_KE : NUMBER(30, 0)

GRCD_TIVE D
TIME_KEY : NUMBER(30, 0}

CREATE DT . DATE LANGUAGE . WVARCHARZ(10)

TIME_DT - DATE SOURCE_LANG : VARCHARZ{10)

DAY _MAME : NWVARCHARZ(30) LOCALE : VARCHARZ(10)

DAY _MBR - NUMBER DAY _MAME : N ARCHARZ(30)
LAST_UPDATE_DT : DATE LAST_ DAY _IN_MTH_IND : N ARCHARZ2({1]
LAST_DAY _IN_MTH_IND : NvARCHARZ(1' TH_NAME : NV ARCHAR2(:30)
WTH_NAME : NvARCHARZ(30) * O VQTR_NAKE : Ny ARCHARZ{30) | S
MTH_NBR : NUMBER TTHOLIDAY WD N ARCHAR2(10)
QTR_MNAME : NYARCHARZ(3D) WWKDAY _IND : NYVARCHAR2(10)
GTR_NBR: NUMBER DAY _ABBREY . WWARCHAR2{30)
FR_MTH : NUMBER MTH_ABEREY : NYARCHARZ{30)

YR_MBR': HUMBER

WK_END_DT : DATE
VWK_START_DT: DATE

WWK_NBR : NUMBER

DAY _NBR_OVERALL : NUMBER
DAY_OF_WK : NUMBER
HOLIDAY_IND - MVARCHAR2{1)
VWKDAY _IND - NVARCHARZ(1)
DAY_ABBREYV | NV ARCHAR2(30)
MTH_NBR_OVERALL : NUMBER

«FK» GRCD_TIME_TL_GRCD_TIME_D_FI1

MTH_ABBREV : NVARCHAR2(30) e e
¥R_QTR: HUMBER BASE TIME_KEY BASE(GRCD TIME D)
VWK_NBR_OVERALL : NUMBER TL LANGUAGE
QTR_NBR_OVERALL : NUMBER TL.SOURCE. LANG
: TLLOCALE ™

[ UK » GRCD_TIME_D_UK1 : TIME_KEY

A5 o
«UK» GRCD_TIME_D_UK2 : TIVE_DT BARELREATE.RT

BASETIME_DT
TL DAY _NAME
BASEDAY _NER
BASELAST_UPDATE_DT
TLLAST DAY _IN_MTH_IND
TL MTH_NAKE
BASE MTH_MER
GRCD_PERICD_D TL.QTR_NAME

" = BASE QTR_MER

TL{GRCD TIME TL}

PERIOD_MAME : MYy ARCHAR2{S0) BASE YR_MTH
PERIOD_DISPLAY ; NVARCHARZ(S0) BASE YR_NBR
START_DATE : TMESTAMP{E) BASEWK_END_ DT
EMND_DATE : TIMESTAMP(E) BASEWK_START DT

i j BASE WH_NBR

<UKe GRCD_PERIOD_D_UIK1 ; PERIOD_NA BASEDAY NBR_CVERALL

BASE DAY _OF WK
TL HOLIDAY _IND
TLWWKDAY_IND

TL DAY_ABBREY

BASE MTH. NBR_OVERALL
TL MTH_ABBREY

BASE YR_QTR
BASEWK_NBR_OVERALL
BASE QTR_NBR_OVERALL

e  Assessments Star
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GRCD_ASSESSMENT_F

PERIOD_NAME : NVARCHAR2(30)
| * |PROCESS_ID : NUMBER 1
o PROCESS_DDOCNAME : NVARCHAR2(30) 3
RISK_ID: NUMBER
|RISK_DDOCNAME : NV ARCHAR2(30)
CONTROL_ID : NUMBER
CONTROL_DDOCNAME : NyARCHAR2(30)
ASSESSMENT_ID : NUMBER
ASSESSMENT_TYPE : NVARCHAR2(100)
DESIGN_RESULT_ID : NUMBER
| DESIGN_EFFECTIVENESS : NVARCHAR2(30)
|5 ORCDLTIVE.D_COMPLETE DT " | DESIGN_RESULT_DATE : TIMESTAMP() £ 0.
. o i) = OPERATING_RESLLT_ID : NUMBER
OPERATING_EFFECTIVENESS : NVARCHAR2(30)
| alias of Time OPERATING_RESULT_DATE : TIMESTAMP()
CURRENT_ASSESSMENT_FLAG : NYVARCHAR2(T)
ENTITY_NAME : NVARCHAR2(30)
ASSESSMENT_TOTAL_CNT : NUMBER
COMPLETION_DATE ; DATE
DUE_DATE : DATE
| TIME_ID ; NUMBER
[ GRCD_PERODD | CERTIFIED_CNT : NUMBER
| 1 NOT_CERTIFIED_CNT : NUMBER
TOTAL _DESIGN_CNT : NUMBER
DESIGN_PASSED_CNT : NUMBER
DESIGN_FAILED_CNT : NUMBER
DESIGN_COMPLETE_CNT : NUMBER
TOTAL_OPERATING_CNT : NUMBER
OPERATING_PASSED_CNT ; NUMBER
OPERATING_FAILED_CNT : NUMBER
OPERATING_COMPLETE_CNT : NUMBER
| i » |SOURCE_ID: VARCHAR2(10)
|7 ASSESSMENT CREATION_DATE : TIMESTAMP(S)
| (0. CREATED_BY : VARCHAR2(SD)
LAST_UPDATE_DATE : TMESTAMP(S)
LAST_UPDATED_BY : VARCHAR2(50)
LAST_UPDATE_LOGIN : VARCHAR2(50)

[ GRCD_TIME_D

/[ PROCESS

{[[E] CONTROL

e Control Tests Star
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GRCD_CONTROL_TEST_F

TIME_ID : NUMBER
PROCESS_ID : NUMEER
CONTROL_ID : NUMBER
CONTROL_TEST_TYPE : NVARCHAR2(10)
0.1 TEST_ID : NUMBER
CREATE_DATE: DATE
|STATE: NVARCHAR2(30)
RESULT_DD : NUMBER
TEST_PERIOD : NY ARCHAR2(30)
TEST_RESULT : NVARCHAR2(30)
[ GRCD_PERIOD.D I + |RESULT_DATE ; TMESTAMP(E) o.
: CURRENT_FLAG : ' ARCHAR2(10)
TOTAL_TEST_CNT : NUMBER
OPEN_TEST_CNT : NUMBER
CLOSED_TEST _CNT : NUMBER
TOTAL_CONTROL_CNT : NUMBER
PASSED_CONTROL_CNT : NUMBER
FAILED_CONTROL_CNT : NUWBER
CANCELED_CONTROL_CNT : NUMBER
SOURCE_ID: YARCHAR2(10)
* | CREATION_DATE : TMESTAMP(E)
~|CREATED_BY | VARCHAR2(50)
LAST_UPDATE_DATE : TIMESTANP(E)
LAST_UPDATED_BY : VARCHAR2(S0)
LAST_UPDATE_LOGIN: VARCHAR2(50)

[ GRCD_TMED /7 PROCESS

[EH ‘CONTROL

[ GRCD_CONTROL_TEST D

e Jssues Star

GRCD_ISSUE_F

[ TIME_ID : NUMBER(10, 0)
ISSUE_ID - HUMBER(10, 0

; ENTITY_TYPE : NVARCHAR2(30)
GRCD_TIME_D ' PROCESS_FLAG : NUMBER(10, 0)
EVALUATION_FLAG : NUMBER(10, 0)
CONTROL. EVAL_FLAG : NUMBER(10,T)
ASSESSMENT_FLAG : NUMBER(10, 0)
PROCESS_ID | NUMBER(10, 0)
'RISK_ID : NUMBER(10, 0)
CONTROL_ID : NUMBER({10, 0)
PROCESS_ISSUE_FLAG - MUMBER(10, 0)
RISK_ISSUE_FLAG : NUMBER(10, 0)

: GRCD_TIME_D_ISSUE_DT L " | CONTROL _ISSUE_FLAG : NUMBER(10, 0)

oA ISSUE_OWMER : Ny ARCHAR2{30)
. ISSUE_SEVERITY : NV ARCHAR2(30)
| alias of Time |ISSUE_STATUS : NV ARCHAR2(30)
ISSUE_DATE : DATE
DUE_DATE : DATE
PERIOD_NAME : NV ARCHAR2({30)
SIGNIFICANT_DEFICIENCY _FLAG : NUMBER(10, 0)
DEFICIENCY_FLAG : NUMBER(10, 0) A
| MATERIAL_WEAKNESS. FLAG - NUMBER(10, 0)
DOCUMENTATION_FLAG : NUMBER(10, 0)
EXPECTEDCOMPLETIONDATE : TIMESTAMP(E)
CLOSED_ISSUE_CNT : NUMBER{10, 0)
OPEN_ISSUE_CNT : NUMBER(10, 0)
ISSUE_CNT : NUMBER{10, 0)
SOURCE_ID : WARCHARZ(10)
CREATION_DATE : TIMESTAMP(E)
CREATED_BY : VARCHAR2(50)
| LAST_UPDATE_DATE : TIMESTAMP(E)
it B poielbproiiill ol
LAST_UPDATE_LOGIN : VARCHAR2(50)

GRCD_PERIOD_D

e Controls Star
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{[F5 GREDLTME D

{69 GRED_CONTROL_FV
|a PROCESSID

Risks Star

a.CONTROLID

b CREATEDATE
ctrl_c_monitoring_crt{CASE TO_CHA
ctrl_c_key_cnt{CASE TO_CHAR(bL.CC
ctrl_c_secondary_crt(CASE TO_CH
ctrl_c:subordinate_crt{CASE TO_CH
cirl_t_preventive_cnt{CASE b CONTR
ctrl_t_detective_cnt{CASE h.CONTRC
ctrl_t_ corrective_cnt{CASE b.CONTR
ctrl_m_autohonitaring_crt{CASE b.C
ctrl_m_manual_cnt{CASE b/ CONTRO|
ctrl_m_automated _crt(CASE b CONT
ctrl_f_multiple_crt(CASE TO_CHAR(E
ctrl_f_daily_crt{CASE TO_CHAR(b.C
ctrl_f_weekly_cnt{CASE TO_CHAR(E
ctrl_f_biweekly_cnt{CASE TO_CHAR
ctrl_f_monthly _crt{CASE TO_CHAR(|
ctrl_f_guartetly_cnt{CASE TO_CHAR
ctrl_f_annually_cnt{CASE TO_CHAR(
ctrl_f_other_ent(CASE TO_CHAR(b.C

E\?’J GRCD:.PROCESS. W

o b(CONTROL)

7]  alPROCESSCONTROLS)

i

k]

Logical and Physical Models
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CONTROL

@ PROCESSID

aRISKID

Controld{CASE  WHEH b CONTR
c RISKRATING

dLOCALE

riskSignificance(e DESCRIPTION)

© RISKSIGMNIFICANCEID
riskLikelihood{d DESCRIPTION)

© RISKLIKELIHOODID

riskType(f DESCRIPTION]
©RISKTYPEID

CreateDate{TO. TIMESTAMP((TRL
processCnt(1)

riskCnt(1)

! A(PROCESSRISKS)
@ a({PROCESSRISKS

b{CONTROLRISKS)
fﬁ B(CONTROL RISKS

|§ c(RISK’

ﬁ fIRISKTYPE TLY

}ﬁ e(RISKEXPOSURETYPE TL

;SQ GiRISKPROBABILITYTYPE TLY
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D

Lineage for GRCM 7.8

This appendix covers the following topics:

* GRCI2.0-GRCM 7.8 Data Lineage CONSTANTS Table
e GRCI2.0-GRCM 7.8 Data Lineage DIMENSIONS Table
* GRCI2.0-GRCM 7.8 Data Lineage FACTS Table

GRCI 2.0 - GRCM 7.8 Data Lineage CONSTANTS Table

The following table provides lineage information on constants, such as type values, that
are loaded from GRCM into GRCL

Common Table Values

The following parameters have common values for all rows in this table.

* Load Type: Script

e File Name: Constants_Load_pkg.sql

Source Table Constant GRCI- Target Create Load
Name Values Table Name Procedure(s) Procedure(s)
N/A 1- 'Low' COMPLEXITYT CREATECOMPL LOADCOMPLE
YPE EXITYTYPE XITYTYPE

2 - 'Med-Low'

3 - 'Medium'

4 - 'Med-High'

5 - 'High'
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Source Table Constant GRCI- Target Create Load
Name Values Table Name Procedure(s) Procedure(s)
GRC_RESOURC N/A COMPLEXITYT LOADCOMPLE
E_STRINGS_TL YPE_TL XITYTYPETL
ComplexityType
N/A 1 - 'Manual’ CONTROLMET CREATECONTR LOADCONTRO
HODTYPE OLMETHODTY LMETHODTYP
2 - 'Automated’
PE E

3 - 'Monitoring'
GRC_RESOURC N/A CONTROLMET LOADCONTRO
E_STRINGS_TL HODTYPE_TL LMETHODTYP

ETL
ControlMethodT
ype
N/A 1 - 'Preventive' CONTROLTYPE CREATECONTR LOADCONTRO
OLTYPE LTYPE

2 - 'Detective'

3 - 'Corrective'
GRC_RESOURC N/A CONTROLTYPE CREATECONTR LOADCONTRO
E_STRINGS_TL _TL OLTYPE LTYPETL
ControlType
N/A 1-'Low' DOCLEVELTYP CREATEDOCLE LOADDOCLEV

E VELTYPE ELTYPE

2 - 'Med-Low'

3 - 'Medium'

4 - 'Med-High'

5- 'High'
GRC_RESOURC N/A DOCLEVELTYP CREATEDOCLE LOADDOCLEV
E_STRINGS_TL E_TL VELTYPE ELTYPETL

DocLevelType
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Source Table Constant GRCI- Target Create Load
Name Values Table Name Procedure(s) Procedure(s)
N/A http://localhost/ ~ GRCD_SERVER CREATESERVE LOADSERVERU
OracleGRCMana URL RURL RL
ger'
‘http://localhost/
analytics/saw.dll
?Dashboard’
N/A 0 - 'Material ISSUESEVERITY CREATEISSUES LOADISSUESEV
Weakness' TYPE EVERITYTYPE ERITYTYPE
1 - 'Significant
Deficiency’
2 - 'Deficiency’
3.
'Documentation
Only'
GRC_RESOURC N/A ISSUESEVERITY CREATEISSUES LOADISSUESEV
E_STRINGS_TL TYPE_TL EVERITYTYPE ERITYTYPETL
IssueSeverity Typ
e
N/A 0 - Process' ISSUETYPE CREATEISSUET LOADISSUETYP
YPE E
1 - 'Evaluation’
2 - 'Control
Evaluation'
3 - 'Assessment’
GRC_RESOURC N/A ISSUETYPE_TL  CREATEISSUET LOADISSUETYP
E_STRINGS_TL YPE ETL

IssueType
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Source Table Constant GRCI- Target Create Load
Name Values Table Name Procedure(s) Procedure(s)
N/A 1 - 'Unreliable’ MATURITYTYP CREATEMATU LOADMATURI
E RITYTYPE TYTYPE

2 - 'Informal’

3-

'Standardized'

4 - 'Monitored'

5 - 'Optimized’
GRC_RESOURC N/A MATURITYTYP CREATEMATU LOADMATURI
E_STRINGS_TL E_TL RITYTYPE TYTYPETL
MaturityType
N/A 1 - 'Process’ PROCESSTYPE  CREATEPROCE LOADPROCESS

SSTYPE TYPE

2 - 'Policy’
GRC_RESOURC N/A PROCESSTYPE_ CREATEPROCE LOADPROCESS
E_STRINGS_TL TL SSTYPE TYPETL
ProcessType
N/A 1- Low' RISKEXPOSURE CREATERISKEX LOADRISKEXP

TYPE POSURETYPE OSURETYPE

2 - 'Med-Low'

3 - 'Medium'

4 - 'Med-High'

5 - 'High'
GRC_RESOURC N/A RISKEXPOSURE CREATERISKEX LOADRISKEXP
E_STRINGS_TL TYPE_TL POSURETYPE OSURETYPETL

RiskExposureTy
pe
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Source Table Constant GRCI- Target Create Load
Name Values Table Name Procedure(s) Procedure(s)
N/A 1 - 'Negligible' RISKPROBABILI CREATERISKPR LOADRISKPRO
TYTYPE OBABILITYTYP BABILITYTYPE
2-'Low E
3 - 'Medium
4 - 'High
5 - 'Extreme’
GRC_RESOURC N/A RISKPROBABILI CREATERISKPR LOADRISKPRO
E_STRINGS_TL TYTYPE_TL OBABILITYTYP BABILITYTYPE
E TL
RiskProbability T
ype
N/A 1 - 'Financial RISKTYPE CREATERISKTY LOADRISKTYP
Fraud' PE E
2 - 'Theft of
Assets'
3 - 'Theft of
Services'
4 - 'Regulatory
Compliance'
5 - '‘Breach of
Security'
GRC_RESOURC N/A RISKTYPE_TL CREATERISKTY LOADRISKTYP
E_STRINGS_TL PE ETL

RiskType

GRCI 2.0 - GRCM 7.8 Data Lineage DIMENSIONS Table

The following tables contain the GRCM source table name that loads the GRCI
dimensions, the procedure name that performs the load, and the file that contains the

procedure.

Common Table Values

The following parameters have common values for all rows in this table.

* Load Type:Script
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e File Name: Dims_Load_pkg.sql (except where noted.)

Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

1. PROCESS

2. GRCD_ACCOU
NT_D

vwDocumentHistory

1. vwDocumentHis

tory
2. Default

Dimension
Values

vwDocumentHistory

1. AuditTest

Control

vwDocumentHis
tory

ControlType

3. ControlMethodT
ype

4. Maturity AsIsTyp
e

MaturityTargetT
ype

ComplexityType

ACCOUNTMAP

ASSERTION

ASSESSMENT

AUDITTEST

AUDITTESTCONTR
OLS

CONTROL

CREATEACCOUNT
MAP

CREATEASSERTION

CREATEASSESSME
NT

CREATEAUDITTEST

CREATEAUDITTEST
CONTROLS

CREATECONTROL

LOADACCOUNTM
AP

LOADASSERTION

LOADASSESSMENT

LOADAUDITTEST

LOADAUDITTESTC
ONTROLS

LOADCONTROL
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Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

Control

2. Risk

Process

2. GRCD_CYCLE_
D

PROCESS
1. GRC_MAP_NO
DES

2. GRC_MAPS

1. GRC_MAP NO
DES_TL

2. GRC_MAPS

CONTROL

Default Dimension
Values

GRC_MAPS,
GRC_MAP_NODES

GRC_MAPS,
GRC_MAP_NODES_
TL

GRC_MAPS,
GRC_MAP_NODES

CONTROLRISKS

FINANCIALMAP

FOURTHMAP

GRCD_ACCOUNT_
D

GRCD_ACCOUNT_T
L

GRCD_CONTROL_H
IERARCHY_B

GRCD_CONTROL_T
EST_D

GRCD_CYCLE_D

GRCD_CYCLE_TL

GRCD_FMAP_D

CREATECONTROLR
ISKS

CREATEFINANCIAL
MAP

CREATEFOURTHM
AP

CREATEACCOUNT
D

CREATEACCOUNTT
L

CREATECONTROLH
IERARCHYB

CREATECONTROLT
ESTD

CREATECYCLED

CREATECYCLETL

CREATEFMAPD

LOADCONTROLRIS
KS

LOADFINANCIALM
AP

LOADFOURTHMAP

LOADACCOUNTD

LOADACCOUNTTL

LOADCONTROLHIE
RARCHYB

LOADCONTROLTES
TD

LOADCYCLED

LOADCYCLETL

LOADFMAPD
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Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

GRC_MAPS,
GRC_MAP_NODES_
TL

GRC_MAPS,
GRC_MAP_NODES

GRC_MAPS,
GRC_MAP_NODES_
TL

GRC_FISCAL_PERIO
DS

GRC_FISCAL_PERIO
DS

File Name:
Execute_Load_GRCD
_TIME_D.sql

UserSecurityAttribute
s

UserSecurity Attribute
S
vwDocumentHistory
DocMeta, Revisions,
Documents

PROCESS

ORGANIZATIONM
AP,

GRCD_ORGANIZAT
ION_D

GRCD_FMAP_TL

GRCD_ORGANIZAT
ION_D

GRCD_ORGANIZAT

ION_TL

GRCD_PERIOD_D

GRCD_TIME_D

GRCD_USER_ROLE

GRCD_USERS

ISSUE

ORGANIZATIONM
AP

CREATEFMAPTL

CREATEORGANIZA
TIOND

CREATEORGANIZA

TIONTL

CREATETIMED

CREATE_GRCD_TIM
E_D

CREATEUSERROLE

CREATEUSERS

CREATEISSUE

CREATEORGANIZA
TIONMAP

LOADFMAPTL

LOADORGANIZATI
OND

LOADORGANIZATI

ONTL

LOADTIMED

LOAD_GRCD_TIME
D

LOADUSERROLE

LOADUSERS

LOADISSUE

LOADORGANIZATI
ONMAP

D-8 Oracle Fusion Governance, Risk and Compliance Intelligence Implementation Guide



Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

VwDocumentHistory
ProcessType,
ComplexityType,

DocLevelType

PROCESS

ACCOUNTMAP

Assessment

Process

Control

Process

Process,

FinancialMap

Process,

FourthMap

Process p

OrganizationMap o

Risk,

Process

vwDocumentHistory

PROCESS

PROCESSACCOUNT
MAP

PROCESSASSESSME
NTS

PROCESSCONTROL
S

PROCESSFINANCIA
LMAP

PROCESSFOURTHM
AP

PROCESSORGANIZ
ATIONMAP

PROCESSRISKS

PROCESSTEST

CREATEPROCESS

CREATEPROCESSA
CCOUNTMAP

CREATEPROCESSAS
SESSMENTS

CREATEPROCESSC
ONTROLS

CREATEPROCESSFI
NANCIALMAP

CREATEPROCESSFO
URTHMAP

CREATEPROCESSO
RGANIZATIONMAP

CREATEPROCESSRI
SKS

CREATEPROCESSTE
ST

LOADPROCESS

LOADPROCESSACC
OUNTMAP

LOADPROCESSASSE
SSMENTS

LOADPROCESSCON
TROLS

LOADPROCESSFIN
ANCIALMAP

LOADPROCESSFOU
RTHMAP

LOADPROCESSORG
ANIZATIONMAP

LOADPROCESSRISK
S

LOADPROCESSTEST
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Source Table Name GRCI - Target Table Create Procedure(s) Load Procedure(s)

Name
vwDocumentHistory, RISK CREATERISK LOADRISK
RiskExposureType,
RiskProbability Type
RiskType,
Default
Dimensionvalues
GRC_SCOPED_CON GRCD_SCOPED_CO LOADSCOPEDCON
TROLS, NTROLS TROLS
CONTROL
GRC_SCOPE_PLANS GRCD_SCOPE_PLA LOADSCOPEPLANS
NS

GRCI 2.0 - GRCM 7.8 Data Lineage FACTS Table

The following tables contain the GRCM source table name that loads the GRCI facts, the
procedure that performs the load, and the file that contains the procedure.

Common Table Values
The following parameters have common values for all rows in this table.

* Load Type: Script

e File Name: Facts_Load_pkg.sql

Source Table Name GRCI - Target Table Create Procedure(s) Load Procedure(s)
Name

1. ControlDesignRe ASSESSMENTCONT CREATEASSESSCTC LOADASSESSCONT

sult ROLDESIGNRESULT DESIGNRESULTS ROLDESIGNRESULT
S S
2. ASSESSMENT
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Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

ControlOperatin
gResult

2. ASSESSMENT

ProcessDesignRe
sult

Assessment

ProcessOperating
Result

Assessment

RiskDesignResul
t

Assessment

RiskOperatingRe
sult

Assessment

vwDocumentHis
tory

Control

1. AuditTestResult

2. AuditTest

vwDocumentHistory,

Control

ASSESSMENTCONT
ROLOPRESULTS

ASSESSMENTPROC
ESSDESIGNRESULTS

ASSESSMENTPROC
ESSOPRESULTS

ASSESSMENTRISKD
ESIGNRESULTS

ASSESSMENTRISKO
PERATINGRESULTS

AUDITTESTRESULT

AUDITTESTRESULT
S

CONTROLDESIGNR
ESULT

CREATEASSESSCON
TROLOPRESULTS

CREATEASSESSBPC
DESIGNRESULTS

CREATEASSESSPRO
CESSOPRESULTS

CREATEASSESSRISK
DESIGNRESULTS

CREATEASSESSME
NTRISKOPRESULTS

CREATEAUDITTEST
RESULT

CREATEAUDITTEST
RESULTS

CREATECONTROLD
ESIGNRESULT

LOADASSESSMENT
CONTROLOPRESUL
TS

LOADASSESSPROCE
SSDESIGNRESULTS

LOADASSESSMENT
PROCESSOPRESULT
S

LOADASSESSRISKD
ESIGNRESULTS

LOADASSESSMENT
RISKOPRESULTS

LOADAUDITTESTR
ESULT

LOADAUDITTESTR
ESULTS

LOADCONTROLDE
SIGNRESULT
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Source Table Name GRCI - Target Table Create Procedure(s) Load Procedure(s)
Name

VwDocumentHistory, CONTROLOPERATI CREATECONTROLO LOADCONTROLOP

NGRESULT PERATINGRESULT ERATINGRESULT
Control
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Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

1. PROCESS

2. PROCESSCONT
ROLS

3. CONTROL
4. ASSESSMENT

5. ASSESSMENTC
ONTROLDESIG
NRESULTS

6.  CONTROLDESI
GNRESULT

olOpResults

8.  CONTROLOPER

ATINGRESULT

ProcessRisks
10.  AssessmentRisk
DesignResults
11. RiskDesignResul
t

12, ASSESSMENTRI
SKOPERATING
RESULTS

13. RISKOPERATIN
GRESULT

14. PROCESSASSES
SMENTS

15.  ASSESSMENTPR
OCESSDESIGNR

ESULTS

AssessmentContr

GRCD_ASSESSMEN
TF

CREATEASSESSME
NTF

LOADASSESSMENT
F

Lineage for GRCM 7.8 D-13



Source Table Name GRCI - Target Table Create Procedure(s)

Load Procedure(s)

Name
16. PROCESSDESIG
NRESULT
17 AssessmentProce
ssOpResults
18. PROCESSOPER
ATINGRESULT
1. AuditTest GRCD_AUDIT_TEST CREATEAUDITTEST LOADAUDITTESTR
_RESULT_F RESULTF ESULTF
2. AuditTestResults
3. AuditTestResult
4. AuditTestContro
Is
3. Control
6. ProcessControls
7. Process
1. GRCD_PROCES GRCD_CONTROL_T CREATECONTROLT LOADCONTROLTES
S_TEST_RESULT EST_F ESTF TF
F
2. ProcessTest
3. GRCD_AUDIT_T
EST_RESULT_F
4 AuditTest
Issue GRCD_ISSUE_F CREATEISSUEF LOADISSUEF
Risk
Control
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Source Table Name

GRCI - Target Table
Name

Create Procedure(s)

Load Procedure(s)

Process
ProcessTest
ProcessTestResult

ProcessTestResults

VwDocumentHistory

Process

VwDocumentHistory

Process

VwDocumentHistory

Control

ProcessTestResult

VwDocumentHistory

Risk

VwDocumentHistory

Risk

GRCD_PROCESS_TE
ST_RESULT_F

PROCESSDESIGNRE
SULT

PROCESSOPERATIN
GRESULT

PROCESSTESTRESU
LT

PROCESSTESTRESU
LTS

RISKDESIGNRESUL
T

RISKOPERATINGRE
SULT

CREATEPROCESSTE
STRESULTF

CREATEPROCESSDE
SIGNRESULT

CREATEPROCESSOP
ERATINGRESULT

CREATEPROCESSTE
STRESULT

CREATEPROCESSTE
STRESULTS

CREATERISKDESIG
NRESULT

CREATERISKOPERA
TINGRESULT

LOADPROCESSTEST
RESULTF

LOADPROCESSDESI
GNRESULT

LOADPROCESSOPE
RATINGRESULT

LOADPROCESSTEST
RESULT

LOADPROCESSTEST
RESULTS

LOADRISKDESIGNR
ESULT

LOADRISKOPERATI
NGRESULT
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Lineage for AACG 8.1.1 or Later

This appendix covers the following topics:
* GRCI2.0-AACG8.1.1 or Later, Data Lineage DIMENSIONS Table
e GRCI2.0-AACG8.1.1 or Later, Data Lineage FACTS Table

GRCI 2.0 - AACG 8.1.1 or Later, Data Lineage DIMENSIONS Table

The following table contains the GRCI staging table name that loads the GRCI

dimensions, and the package that loads the target GRCI dimension table.

It is important to note that all these packages are invoked from GRI_MASTER_PKG

Common Table Values

The following parameters have common values for all rows in this table.

* Master Package: GRI_MASTER_PKG

Error Table Dimension/B Create Package Sub-Packag Interface
Name ridge Table Procedure(s) Name e Name Name
Package
GRI_DIMEN GRI_INSTAN GRI_D_INST GRI_D_INST
SIONS_PKG CE_PKG ANCE_PKG  ANCE_INTR
GRI_DIMEN GRI_INSTAN GRI_D_INST GRI_D_INST
SIONS_PKG CE_PKG ANCE_TL_P ANCE_TL_I
KG NTR
GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
SIONS_PKG C_DIM_PKG ERIC_DIM_P ERIC_DIM_I
KG NTR
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Error Table Dimension/B Create Package Sub-Packag Interface
Name ridge Table Procedure(s) Name e Name Name
Package
GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
SIONS_PKG C_DIM_PKG ERIC_DIM_T ERIC_DIM_T
L_PKG L_INTR
GRI_E_GENE GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
RIC_DIM_V  SIONS_PKG C_DIM_PKG ERIC_DIM_V ERIC_DIM_V
AL AL_PKG AL_INTR
GRI_DIMEN GRI_GENERI GRI_D_GEN GRI_D_GEN
SIONS_PKG C_DIM_PKG ERIC_DIM_V ERIC_DIM_V
AL_TL_PKG AL_TL_INTR
GRI_DIMEN CREATEACC GRCD_USER GRCD_USER GRCD_USER
SIONS_PKG OUNTMAP _MAIN_PKG _PKG _INTR
GRI_DIMEN GRCD_USER GRCD_USER GRCD_USER
SIONS_PKG _MAIN_PKG _TL_PKG _TL_INTR
GR_E_POLIC GRI_DIMEN GRI_POLICY GRI_D_POLI GRI_D_POLI
Y SIONS_PKG _PKG CY_PKG CY_INTR
GRI_DIMEN GRI_POLICY GRI_D_POLI GRI_D_POLI
SIONS_PKG _PKG CY_TL_PKG CY_TL_INTR
GRI_E_ENTI = GRI_DIMEN GRI_ENTITL GRI_D_ENTI GRI_D_ENTI
TLEMENT SIONS_PKG EMENT_PKG TLEMENT_P TLEMENT I
KG NTR
GRI_DIMEN CREATEASS GRI_ENTITL GRI_D_ENTI GRI_D_ENTI
SIONS_PKG  ERTION EMENT_PKG TLEMENT_T TLEMENT_T
L_PKG L_INTR
GRI_DIMEN CREATEASS GRI_ACCESS GRI_D_ACC GRI_D_ACC
SIONS_PKG  ESSMENT _POINT_PK  ESS_POINT_ ESS_POINT_I
G PKG NTR
GRI_DIMEN CREATEAU GRI_ACCESS GRI_D_ACC GRI_D_ACC
SIONS_PKG  DITTEST _POINT_PK  ESS_POINT_ ESS_POINT_
G TL_PKG TL_INTR
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Error Table Dimension/B Create Package Sub-Packag Interface
Name ridge Table Procedure(s) Name e Name Name
Package
GRI_DIMEN CREATEAU GRI_APPS_ U GRI_D_APPS GRI_D_APPS
SIONS_PKG  DITTESTCO  SER_PKG _USER_PKG _USER_INTR
NTROLS
GRI_DIMEN CREATECO GRI_APPS_U GRI_D_APPS GRI_D_APPS
SIONS_PKG  NTROL SER_PKG _USER_TL_P _USER_TL_I
KG NTR
GRI_DIMEN CREATECO GRI_ROLE_P GRI_D_ROLE GRI_D_ROLE
SIONS_PKG NTROLRISK KG _PKG _INTR
S
GRI_DIMEN CREATEFIN GRI_ROLE_ P GRI_D_ROLE GRI_D_ROLE
SIONS_PKG ANCIALMA KG _TL_PKG _TL_INTR
P
GRI_DIMEN CREATEFOU GRI_D_RUN GRI_D_RUN GRI_D_RUN
SIONS_PKG RTHMAP _PKG _PKG _INTR
GRI_E_EXCL GRI_DIMEN CREATEACC GRI_EXCLUS GRI_D_EXCL GRI_D_EXCL
USION SIONS_PKG  OUNTD ION_PKG USION_PKG  USION_INTR
GRI_E_EXCL GRI_DIMEN CREATEACC GRI_EXCLUS GRI_D_EXCL GRI_D_EXCL
USION_DET SIONS_PKG OUNTTL ION_PKG USION_DET USION_DET
AIL AIL_PKG AIL_INTR
GRI_E_PATH GRI_DIMEN CREATECO GRI_EXCLUS GRI_D_PAT GRI_D_PAT
_EXCLUSIO SIONS_PKG NTROLHIER ION_PKG H_EXCLUSI  H_EXCLUSI
N ARCHYB ON_PKG ON_INTR
GRI_BRIDGE CREATECO GRI_D_ROLE GRI_D_ROLE GRI_D_ROLE
_TABLES_PK NTROLTEST _USER BG_P _USER_BG_P _USER_BG_I
G D KG KG NTR
GRI_BRIDGE CREATECYC GRI_D_POLI GRI_D_POLI GRI_D_POLI
_TABLES_PK LED CY_GENERI CY_GENERI CY_GENERI
G C_DIM_BG_ C_DIM_BG_ C_DIM_BG_I
PKG PKG NTR

Lineage for AACG 8.1.1 or Later

E-3



Error Table Dimension/B Create Package Sub-Packag Interface

Name ridge Table Procedure(s) Name e Name Name
Package
GRI_BRIDGE CREATECYC GRI_D_POLI GRI_D_POLI GRI_D_POLI
_TABLES_PK LETL CY_DETAIL_ CY_DETAIL_ CY_DETAIL_
G BG_PKG BG_PKG BG_INTR
GRI_BRIDGE CREATEFM  GRI_D_ENTL GRI_D_ENTL GRI_D_ENTL
_TABLES_PK APD MNT_GENE MNT_GENE MNT_GENE
G RIC_DIM_BG RIC_DIM_BG RIC_DIM_BG

_PKG _PKG _INTR

GRI_BRIDGE CREATEFM  GRI_D_ENTI GRI_D_ENTI GRI_D_ENTI
_TABLES_PK APTL TLEMENT_A TLEMENT_A TLEMENT_A
G P_BG_PKG P_BG_PKG P_BG_INTR

GRCI 2.0 - AACG 8.1.1 or Later, Data Lineage FACTS Table

The following table contains the GRCI staging table name that loads the GRCI fact
tables, and the package that loads the target GRCI fact table.

NOTE:It is important to note that all these packages are invoked from the fact package
GRI_FACTS_PKG, which in turn is invoked from GRI_MASTER_PKG.

Common Table Values
The following parameters have common values for all rows in this table.

¢ Load Type:ODI
* Master Package:GRI_MASTER_PKG

e Fact PackageGRI_FACTS_PKG
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SINO.

Source
Table
Name(s)

Target Table
Name

Error Table
Name

Package
Name

Interface
Name

GRI_S_CONF
LICTS

GRI_D_RUN

GRI_D_POLI
CYy

GRI_D_GBL_
USER

GRI_A_LOO
Kup
GRI_F_CONF
LICTS_T
GRI_D_POLI
CY
GRI_S_CONF
LICT_PATH
GRI_D_RUN

GRI_D_POLI
CY

GRI_D_APPS
_USER

GRI_D_ACC
ESS_POINT

GRI_D_ENTI
TLEMENT

GRCD_USER
S

GRI_A_LOO
Kuop

GRI_F_CONF
LICTS_T

GRI_D_POLI
CY_PREV_R
UN_BG

GRI_F_CONF
LICT_PATH_
T

GRI_E_CON
FLICTS_T

GRI_E_CON

FLICT_PATH

T

GRI_F_CONF
LICTS_T_PK
G

GRI_D_POLI
CY_PREV_R
UN_BG_PKG

GRI_F_CONF
LICT_PATH_
T_PKG

GRI_F_CONF
LICTS_T_INT
R

GRI_D_POLI
CY_PREV_R
UN_BG_INT
R

GRI_F_CONF
LICT_PATH_
T_INTR
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SI NO. Source Target Table Error Table Package Interface
Table Name Name Name Name
Name(s)

4 GRI_S_CONF GRI_F_CONF GRI_E_CON GRI_F_CONF GRI_F_CONF
LICT_PATH LICT_PATH_ FLICT_PATH LICT_PATH_ LICT_PATH_

_T T_PKG_2 T_INTR_2
GRI_D_RUN

GRI_D_POLI
CYy

GRI_D_POLI
CY_INSTAN
CE_V
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